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Module Title: Operating Personal Computer 
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This module includes the following Learning Guides  

LG24: Access basic information system 

LG Code: ICT ITS1M07L02-LG-24 

LG25: Navigate and Manipulate   Desktop Environment 

LG Code: ICT ITS1 M07 L03-LG-25 

LG26: Organize Basic Directory/ Folder Structure and File 

 LG Code: ICT ITS1 M07 L04-LG-26 

LG27: Organize files for users and/or Organization Requirements 

 LG Code: ICT ITS1 M07 L05-LG-27 

LG28: Print Information 

 LG Code: ICT ITS1 M07 L06-LG-28 

LG29: Operate Application Software 

 LG Code: ICT ITS1 M07 L07-LG-29 
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Instruction Sheet       LG24: Access basic information system 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics – 

 Inserting user name and password to access computer desktop environment 

 Navigating operating system to access system information  

 Using On-line get help functions  

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to: - 

 Insert user name and password as prompted and noted access, privacy, security and 

related conditions of use displayed on introductory screens  

 Navigate operating system to access system information to identify system 

configuration and application versions in operation  

 Use on-line help functions as required  

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 3 to 6.  

3. Read the information written in the information “Sheet 1, Sheet 2, Sheet 3” in page -3, 

8 and 16 respectively. 

4. Accomplish the “Self-check 1, Self-check t 2 and Self-check 3” in page -7, 15 and 19 

respectively.  

5. If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation 

Sheet 2 and Operation Sheet 3” in page -20 and 22 respectively. 

6. Do the “LAP test” in page – 23 (if you are ready).  

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your teacher shall advice you on additional work. But if satisfactory you 

can proceed to the next topic. 
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Information Sheet 1 
Inserting user name and password to access computer 

desktop environment 

1.1. Getting familiar with the desktop environment 

1.1.1. Using the mouse 

One of the most useful tools for working on a computer is the mouse. The mouse is used to 

move a pointer or cursor around the screen, in order to select a button or icon to perform a 

particular task, or to access, move or copy data. When you create your own files using 

application software (like a word processor) you’ll use the mouse to help you write and edit 

text or other data.  

So before you start to navigate around the computer, make sure you are comfortable with 

using the mouse. It may take some time and practice to get this. 

 
Mouse pointer: On the screen, the mouse usually appears as a small white or 

black arrow. When you move your mouse on a flat surface, the arrow will match the 

movement on the screen. 

To move the mouse pointer, move the mouse across the mouse pad and watch the pointer on 

the screen move in the same direction. Practice moving the mouse now.  

 

Doing tasks with the mouse 

There are a variety of mice available. Apple computers have a single button, while PCs can 

have either two buttons (a left and a right button) or three buttons (left, middle, right). The left 

and right mouse buttons, however, are commonly used by PC operating systems. 

Some common ways that you can use a mouse with two buttons include: 

 Left-click: One click of the left mouse button allows you to choose something on 

the screen. 

 Right-click: One click of the right mouse button will often open up a shortcut menu. 

 Double-click: Quickly clicking the left button twice allows you to open a selected 

file or folder. 

 Click-drag: Left-click on an item, such as a file icon, and keep holding the mouse 

button down, then drag the item to move it to a new location. Another common 

function that click-drag performs is with text. For example, when you are inside a 
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word document, left-click at the start of a sentence and drag to the end of the 

sentence to select that sentence. 

 

 

 

 

 

 

Figure 1: A mouse with two buttons and a scroll wheel 

A mouse may also have the additional feature—a scroll wheel—that enables you to use the 

mouse to scroll up and down a window instead of using the window’s scroll bars. 

 

1.1.2. Desktop windows 

The desktop is the background screen that appears as soon as the computer has finished 

starting up. The desktop is part of the operating system software, so its appearance is 

controlled by system settings. There are several useful items on the desktop including: 

 

Icons: An icon is a small picture that may appear on your desktop. Double left-clicking on 

an icon is an easy way to open a program, files or other items (such as storage drives). 

Icons allow you quick access to all of these items. 

It is very important to become familiar with how to work with windows on the computer. A 

window is an area on the screen that displays programs or information. For example, windows 

are a device the operating system uses to display a list of the contents of a folder. A window 

can be moved, resized, opened and closed. Many operating systems allow you to have 

several windows open at any time, so you can easily move around between areas.  

Windows are also used in application programs to display a document when it is open. 

There are several features of windows including: 

 Title bar: This is a bar that appears at the top of the window. It often includes the 

name of the program or folder. 

 Minimize: This option shrinks the window to its smallest size. It will now only 

appear as an option on the task bar. The program is still open; left-clicking on it in 

the taskbar will restore it to its regular size. 
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 Maximize: This options makes the window expand to its largest size. 

 Close: This will close the window. If you need to save your work, a program will 

usually ask you to save before closing. 

 Scroll bar: This is a slider on the right-hand side of the window that allows you to 

move down the contents of the window, in the same way you might have scrolled 

down a website page. Left-click and drag the slider, or left-click on the down and up 

arrows in order to move up or down the window contents. 

  

Minimize 

 

Maximize 

 

Close 

Figure 2: Buttons that appear in Microsoft Windows operating system windows—to minimise, 

maximize and close a window. These buttons sit at the top right-hand corner of every window. 

1.1.3. The task bar 

The Task bar is a horizontal bar at the very bottom of the desktop. It shows any applications 

or windows that are open. If there is more than one document open in an application, it will 

show the name of the application and the number of files open. It also shows the time and 

short cuts for any other items open on the desktop. 

1.1.4. The Start menu 

You can left-click the Start button on the Task bar to see the Start menu. This menu allows 

you to: 

 access information about the computer system you are using 

 access controls for changing the way that information is displayed 

 access application programs that are installed on the computer. 
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Next we’ll look at the settings you can access in the Control Panel. The Control Panel can be 

selected in the Start menu. 

 

 

 

 

 

 

 

 

Figure 3: The Start menu where you can access system information and change display 

settings (in the Control Panel), and open the application programs 
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Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the next 

page: 

1. An ___ is a small picture that may appear on your desktop. 
A. Scroll bar 

B. Title bar 
C. Task bar 

D. Icons 

E. Minimize: 

2. This is a bar that appears at the top of the window 

A. Scroll bar 
B. Title bar 

C. Task bar 

D. Icons 
E. Minimize 

3. This option shrinks the window to its smallest size. 
A. Scroll bar: 

B. Title bar 
C. Task bar 

D. Icons 

E. Minimize 

4. This is a slider on the right-hand side of the window that allows you to move down the 
contents of the window 

A. Horizontal Scroll bar 

B. Title bar 
C. Task bar 

D. Vertical Scroll bar 

E. Minimize 

5. The ________is a horizontal bar at the very bottom of the desktop. It shows any 
applications or windows that are open. 

A. Scroll bar: 

B. Title bar 
C. Task bar 

D. Icons 

E. Minimize: 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 2 
Navigating operating system to access system 

information  

 

2.1. Accessing system information and settings 

2.1.1. The Control Panel 

The Control Panel enables you to view and change settings to things like: 

 The display—screen savers, patterns, appearance, wallpapers. 

 Date and time 

 The system—resources that the system has available such as devices listed in 

the hardware tab. 

 Printers and faxes—shows printers and faxes and their settings. There are other 

options that you could use once you are more confident. 

The Control Panel window contains many icons that represent different controls, players 

or information about the computer system. You can access any of these by double left-

clicking on an icon. 

Look at Figure 4 on the next page. Find the icons for: 

1 Date and time 

2 Display 

3 Folder options 

4 Printers and Faxes. 

Figure 4: The Control 

Panel window where 

you can access 

information and 

system settings by 

double-clicking on the 

icons 

1.  
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2.1.2. Customize the desktop 

It is possible to customize your desktop, for example, to change the background pattern 

and the style of the text displayed by the operating system. You do this through the 

Control Panel through the Display icon. 

Now, on your own computer, follow the steps below to customize the desktop on your 

computer. 

1 Left-click on Start on Task bar. 

2 Left-click on Control Panel. 

3 Double left-click on the Display icon. 

The Display Properties box will appear. 

 

Figure 5: The Display Properties box (in Windows XP) 

Notice the tabs across the top of the box—these provide options for changing display 

properties: 

 Themes 

 Desktop 

 Screen Saver 

 Appearance 

 Settings. Click on each tab to see the different options. 
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2.1.3. Appearance 

Figure 6.  below show the options under the Appearance tab.  

Change the color scheme and font size 

Note: From now on the word ‘click’ refers to the left mouse button. 

1 Select ‘Windows style’ from the Windows and Buttons option. To do this, click on 

the arrow to see a drop-down menu which lists the options. Then move the mouse 

pointer down the list to select the option you want. 

2 Select a Colour scheme in the same way you changed the Windows and 

Buttons option. Notice how the colour scheme changes on your desktop as you 

choose different options. 

3 Now change the font size, for example, try ‘Large’. 

4 Click on OK to save the changes you have made OR click on Cancel if you don’t 

want to save the changes. 

Figure 6: Options under the Appearance tab 

 

 

 

  

 

2.1.4. 
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2.1.4. Change the date and time 

Follow these steps to change the date and time on your computer clock. 

1. Click on Start on the Task bar. 

2. Click on Control Panel. 

3. Double-click on the Date and Time icon.  

The tabs here give you options for how the   time and date is displayed and allow 

you to set the correct time on the computer’s clock if necessary. Check the 

following options are set on your computer: 

1. Click on the Time Zone tab. 

2. Select ‘Aus Eastern Standard Time’ from the drop-down menu. 

3. Click on the Date & Time tab. 

4. Click on the drop-down menu and select the correct month. 

5. Use the up and down arrows to select the year. 

6. Click on the date in the calendar to select the day. 

7. Under the clock, use the up and down arrows to select the correct time. 

8. Click on OK to save the changes you made OR click on Cancel if you don’t want to 

save the changes. 

 

Figure 7: Date and Time properties box (in Windows 7) 
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2.1.5. Check printers and faxes 

Now we’ll look at how to check the settings for the printers that are connected to your 

computer. 

1. Open the Control Panel. 

2. Double-click the Printers and Faxes icon. 

Figure 9: Printers and Faxes options (in Windows 7) 

1. Click on a printer to see the corresponding list of Printer Tasks listed to the left. To 

perform any of these tasks, click on the task name in the list. 

2. Right-click on the printer icon to see a drop-down menu with additional options. 

(See Figure 9 below. Note you may have different printer names on your 

computer.) 

 

 

Figure 9: A drop-down menu appears when you right-click on a printer icon 
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2.1.6. Change printer preferences 

Follow these steps to see the options available for your printer. 

1 Right-click on a printer icon and select (with a left-click) 

 Printing Preferences from the drop-down list. 

2 In the Preferences box, click on each of the tabs and notice  

the options that are available. You can change the paper  

size or paper orientation under the Page Setup tab (see  

 

Figure 10 below). Features that your printer does not have will be 

greyed out (faded) and you won’t be able to use these options. 

 

 

3. Click on Cancel to close the preferences box without saving any changes. 

4. Click on the Close button to close the Control Panel. 

Figure 10: Printer preferences box for printer 
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2.1.7. Open and close an application program 

Follow these steps to see what programs are installed on your computer and to open one 

of the programs.  

1. In the Start menu, click on All Programs to see a list of all the application 

programs on the computer. 

2. Move the mouse across to the list of programs and then up or down the list to the 

program you want to use. Click on the name of the program to open it. 

3. Note that if a name has a small arrow next to it, a sub-menu appears when you 

click on the name. See Figure 11. 

4. If your computer has Microsoft Office listed under All Programs, click on Microsoft 

Office. Then move the mouse across to the sub-menu and click on Microsoft Office 

Word. 

5. The program will take a few moments to open. A new blank document will be 

displayed in the Microsoft Word window. 

Figure 11: Click on Microsoft Office then move the mouse across to the sub-menu and 

click on Microsoft Word 

Close the program  

To close the program click on the Close button  at the top right of the window. 
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Self-Check -2      Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

1. The _________ enables you to view and change settings 

A. Date and time 

B. Printers 

C. Folder options 

D. Control Panel 

2. One is deferent from others 

A. Themes 

B. Desktop 

C. Screen Saver 

D. Appearance 

E. Fax 

3. In the Start menu, click on All Programs to see a list of all the application 

programs on the computer. (True/False) 

 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

 

Information Sheet 3 Using On-line get help functions  

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  

You can ask you teacher for the copy of the correct answers. 
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3.1. Getting online help 

Online help is a facility provided with most application programs and operating systems. It 

gives you assistance with all of the functions and features of the product you are using. If 

you are using later versions of the software you can also connect directly to the software 

website for further tutorials, definitions and assistance. 

Using online help in Windows 7 

Follow these steps to use online help in Windows 7 Professional. 

1. Under the Start menu, select Help and Support. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 12: Help and Support in Windows 7 can be accessed under the Start menu 

2. At the Help and Support Centre there are Help topics you can browse 

through, or you can use the Search field to enter a keyword and find help. 

3. Figure 13: Help and Support Centre in Windows 7 

4. In the Search field, type in the word ‘printers’ and click on the green arrow. 

Look at the tasks and topics in the search results. If you want to get help 

for any task or topic, click on the item in the list. 

5. To try another search, click inside the search box and press the Delete key 

on your keyboard to delete the word ‘printers’. Then type in a new word 

or phrase.  
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To go back to the Help and Support Centre home screen, click on the Back button at 

the top left-hand side of the window. 

Getting online help in an application 

All the popular programs also have an inbuilt 

help facility. This facility might include tutorials for 

learning the program. 

For example, there are two ways you can 

access the Help options in Microsoft Word: 

6. Click on the Help menu to see the 

Help-related items, including the 

Microsoft Office website. OR 

Press the F1 key on your keyboard. This is the first 

‘F’ key on the very top row of the keyboard. Click on 

some of the choices and look at the help that is available. Get help for printing a document 

You can use the Word Help to search for help topics or browse topics under the  

Table of Contents.  

Figure 14: Microsoft Office Word Help 
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3.2. To search for help to print a document: 

1. Under the Help menu click on Microsoft Office Word Help OR press the F1 key to 

open Help. 

2. Type the word ‘printing’ in the Search for: box. 

3. Click on the green arrow. The computer will search the Microsoft Help site and 

provide a list of tasks and topics that might be useful. Click on any item to get the 

help information. 

4. Scroll down the list of items and click on any you think may be useful. 

3.3. To browse for help to print a document: 

1. Click on Table of Contents (directly under the Search for: box). 

2. Click on Printing. A sub-list of topics for ‘printing’ appears. 

3. Click on any of the topics that may be helpful. 

To close the Help facility click on the Close button . 

Type a question for help 

In Microsoft Word, you can also type a question for help on the main menu bar. At the top 

right-hand corner of the window (on the menu bar) there is a box where you can type a 

question for help. 

 

Figure 15: In Microsoft Word you can type a question for help on the main menu bar  

1. Click inside the box (where it says ‘Type a question for help’). 

2. Type in your question. For example, try ‘How do I save a document?’ Look at 

the items that appear in the results. Click on one that sounds most relevant 

to your question. Now try your own question. 

 

 

 
 



 

ICT ITS1 

Version:01 

Page No.20 
Copyright: Ethiopia Federal TVET  Agency 

 

 

Self-Check -3 

 

Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

 

1. __________ is a facility provided with most application programs and 

operating systems? 

2. Write the procedure to search printer installation process from w7 ? 

___________________________________________ 

_____________________________________ 

                           _____________________________________ 

 

 

 

 

 

 

 

 

 

 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Operation Sheet 2 
Navigating operating system to access system 

information  

 

Task1: steps below to customize the desktop on your computer. 

1 Left-click on Start on Task bar. 

2 Left-click on Control Panel. 

3 Double left-click on the Display icon. 

 

Task2: Change the color scheme and font size 

1 Select ‘Windows style’ from the Windows and Buttons option.  

2 Select a Colour scheme in the same way you changed the Windows and 

Buttons option.  

3 Now change the font size, for example, try ‘Large’. 

4 Click on OK to save the changes you have made OR click on Cancel if you don’t 

want to save the changes. 

 

Task3:  steps to change the date and time on your computer clock. 

1. Click on Start on the Task bar. 

2. Click on Control Panel. 

3. Double-click on the Date and Time icon.  

OR 

options are set on your computer: 

1. Click on the Time Zone tab. 

2. Select ‘Aus Eastern Standard Time’ from the drop-down menu. 

3. Click on the Date & Time tab. 

4. Click on the drop-down menu and select the correct month. 

5. Use the up and down arrows to select the year. 

6. Click on the date in the calendar to select the day. 

7. Under the clock, use the up and down arrows to select the correct time. 

8. Click on OK to save the changes you made OR click on Cancel if you don’t 

want to save the changes. 
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Task4: Check printers and faxes 

1. Open the Control Panel. 

2. Double-click the Printers and Faxes icon. 

OR 

1. Click on a printer to see the corresponding list of Printer Tasks listed to the left. To 

perform any of these tasks, click on the task name in the list. 

2. Right-click on the printer icon to see a drop-down menu with additional options.  

 
 

Task5:  Steps to see what programs are installed on your computer and to open one of 

the programs.  

1. In the Start menu, click on All Programs to see a list of all the application 

programs on the computer. 

2. Move the mouse across to the list of programs and then up or down the list to the 

program you want to use. Click on the name of the program to open it. 

3. Note that if a name has a small arrow next to it, a sub-menu appears when you 

click on the name.  

4. If your computer has Microsoft Office listed under All Programs, click on Microsoft 

Office. Then move the mouse across to the sub-menu and click on Microsoft Office 

Word. 

5. The program will take a few moments to open. A new blank document will be 

displayed in the Microsoft Word window. 
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Operation Sheet 3 Using On-line get help functions  

 

Task1: Follow these steps to use online help in Windows 7 Professional. 

1. Under the Start menu, select Help and Support. 

2. At the Help and Support Centre there are Help topics you can browse 

through, or you can use the Search field to enter a keyword and find help. 

3. In the Search field, type in the word ‘printers’ and click on the green arrow. 

Look at the tasks and topics in the search results. If you want to get help 

for any task or topic, click on the item in the list. 

4. To try another search, click inside the search box and press the Delete key 

on your keyboard to delete the word ‘printers’. Then type in a new word 

or phrase.  

Task2: To browse for help to print a document: 

1. Click on Table of Contents (directly under the Search for: box). 

2. Click on Printing. A sub-list of topics for ‘printing’ appears. 

3. Click on any of the topics that may be helpful. 

 

Task3: Microsoft Word you can type a question for help on the main menu bar  

1. Click inside the box (where it says ‘Type a question for help’). 

2. Type in your question. For example, try ‘How do I save a document?’ Look at 

the items that appear in the results. Click on one that sounds most relevant 

to your question. Now try your own question. 
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Lap Test Practical Demonstration 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________  Time finished:  ________________ 

Instructions: Given necessary templates, tools and materials you are required to 

perform the following tasks within --- hour. 

 

Task 1: Change display settings 

  

          From the Control Panel, make the following changes to your Display settings. 
 

 Desktop 

  Change the desktop pattern to “Ripple” 
 

 Screen saver 

  Change the screen saver setting to “Marquee”. 

  Select the slowest speed 
 

 Text style (Settings) 

  Change the Font to “Courier”. 
  Set the font size to 48 

  Set the font color to Aqua 
  

Task 2: Add a printer 

 
Task 3: Copy your computer Basic system information 

 

Task 4: Access online help and application software. 

 Show how to get windows online help  
 

 Show to get application online help 
 - MS Word 

 

 

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your trainer shall advice you on additional work. But if satisfactory, 

you can proceed to the next topic. 
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Instruction Sheet  
LG25: Navigate and Manipulate   Desktop Environment 

 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics – 
 Creating and Customizing Desktop icons  

 Selecting, Opening and Closing desktop icons to access application programs       

 Manipulating Application windows to return original conditions 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 

 Create and customize desktop icons 

 Select, open and close desktop icons to access application programs   
 Manipulate application windows and return desktop to original conditions  

 
Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 3 to 6.  

3. Read the information written in the information “Sheet 1, Sheet 2 and Sheet 3” in 

page -3, 11 and 13 respectively. 

4. Accomplish the “Self-check 1, Self-check t 2 and Self-check 3” in page -10, 12 and 

14 respectively.  

5. If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation 

Sheet 1, Operation Sheet 2 and Operation Sheet 3” in page -15,17,18 respectively. 

6. Do the “LAP test” in page – 19 (if you are ready).  

 
 

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 
unsatisfactory, your teacher shall advice you on additional work. But if satisfactory 
you can proceed to the next topic. 
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Information Sheet 1 Creating and Customizing Desktop icons  

1.1. Desktop Overview 

A computer desktop provides you with an easy way of identifying, organising and 

accessing stored data and programs on your computer.  

A computer desktop can display shortcuts to get to application programs and storage 
devices (such as the hard drive). You can also create your own shortcuts to places on a 

hard drive or network, so that you can open particular websites or files and folders 

quickly. 

All these shortcuts are displayed on the desktop as icons. There are different styles of 

icons depending on what they represent (although later you find out how you can change 

an icon graphic to suit your preference). To go to the shortcut, you double-click on the 
icon. 

 

 

Icon for Internet 
Explorer. Double-
click this icon to open 

the program 

 

Icon for accessing 
shared files on a 
network. Double-

click this icon to go 
to the network 

 

Icon for a shortcut to 
a folder that is on the 
computer’s hard 

drive. Double-click 
this icon to go to 

open the folder 

 

Icon for a shortcut to 
a website. Double-
click this icon to go 

to the website 

Figure 1: Different styles of icons you might find on the desktop 

The desktop loads after you start up a computer that is running a windows-based 

operating system like Microsoft Windows 7 or Other OS. 

If you are using a Microsoft Windows operating system you will see the Start button (to get 

to the Start menu) on the bottom left and some desktop icons. 
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1.2. Create desktop icons/shortcuts 

Now try customising your own icons/shortcuts on your desktop. For the following 

examples, the operating system Windows is used. We will practice two ways of creating a 

desktop icon: 

1.  Click and drag an item from a menu. 

2.  Use the Create shortcut command in a window’s File menu. 

Create a desktop icon to open the Control Panel 

Follow these steps using your own computer. 

1. Click on Start on the Task Bar. 
2. Click on the menu item Control Panel but keep the mouse button held down and 

drag the mouse pointer from the Control Panel to the Desktop. 

3. The following icon will now be on your desktop: 

 

 

 

You have now created a desktop item which will allow you to open the Control Panel from 
the desktop instead of going through the Start menu. 

Create a desktop icon to open a program 

1. Click on Start on the Task Bar. 

2. Click on All Programs. 

3. Under All Programs, click on Accessories. 

4. Under Accessories, click on Paint and drag this item to the desktop. (If you don’t 

have Paint on your computer then select a different program.) 

5. You should now have an icon/shortcut to the program on your desktop. 
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1.3. Create a desktop icon to open the DVD/CD drive 

You can also place shortcuts to storage media drives on the desktop. You would do this if 

you are regularly using these items. 

1. Double-click on My Computer (on the desktop).  

2. Click DVD/CD Drive and drag this item to the Desktop. 

3. The following icon will now be on your desktop:      

 

1.4. Create a desktop icon to open a folder 

When you have a lot of folders stored on the computer, shortcuts to folders you regularly 

use are very handy. 

1. Double-click on My computer (on the desktop).  
2. Double-click on one of the drives listed under Hard Disk Drives. You will now see a 

list or group of folders that are stored on that drive. 

3. Click once on one of the folders stored on the drive. The name of the folder will now 
be highlighted (which means it is selected). 

4. Click on the File menu at the top of the window and move down the menu and click 

on  
Create Shortcut. (See Figure 2.) 
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Figure 2: Create Shortcut under the File menu 

5.  A new folder called ‘Shortcut to… (the name of the folder)’ appears in the window. 
Click and drag this shortcut item to the desktop. 

6. The following icon will now be on your desktop (but with a different folder name): 

 

 

 

1.5. Customize the appearance of icons 

Rename an icon 

You can rename any icons on the desktop such as a shortcut to a folder. 

1.  Right-click on the icon you want to rename so that a menu appears. 

2.  Move the mouse down the menu and select Rename. The name of the icon is 

now highlighted (which means it is selected). 

 

Figure 1: Right-click on an icon to rename or delete an icon 

1. Use the keyboard to type the new name for the icon. The text that you type will 

replace the highlighted text. 
2. Press Enter on the keyboard OR click anywhere on the desktop to save the new 

name. 

Delete a shortcut/icon 

You can delete a shortcut when you no longer need it. Note that if an icon is actually the 

file to open a program, and not just a shortcut to it, then you probably don’t want to delete 

this! 
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Delete the shortcut to the DVD/CD drive: 

1.  Right-click on the DVD/CD icon/shortcut so that a menu appears. 

2.  Click on Delete. 

3.  Click on Yes to confirm you want to delete this icon. 

The desktop icon/shortcut for the DVD/CD drive will be deleted but you will still be able to 
access the drive through My Computer. Only the shortcut has been deleted. 

Change the picture for a shortcut/icon 

You can change the picture for a shortcut/icon by selecting from a range of icons provided 

by the operating system. 

1. Right-click the shortcut/icon you want to change so that a menu 

appears. 

2. Click on Properties. 

3. Under the Shortcut tab, click on Change Icon. (See Figure 4.) 
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Figure 2: Changing the picture for an icon  

4.  Click on the icon picture you want then click the OK button. (See 
Figure 5.) 

 

 

 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 

Figure 3: The globe icon is selected for My photos shortcut 
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Change the size of icons 

You can change the size of icons and the text related to the icons. 

1. Right-click on an empty area of the desktop—not on an icon. A menu appears. 

2. Click on Properties. A Properties box appears. 

3. In the Properties box click on the Appearance tab. 

4. Click on the Advanced button. 

5. Select ‘Icon’ from the Item drop-down box (See Figure 3.) 

6. Change the size of all icons by clicking on the down or up arrows under Size: (for 
Item:). 

7. Change the size of the text related to icons by clicking on the Font size arrows. 

8. Click OK to make the changes OR Cancel to return to the desktop without making 

changes. If you want to make the changes, note the original settings (so that you 
can return and put the sizes back to their original settings). 

Figure 4: Changing the size of an icon (Item) and the size of the icon text (Font). 
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Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

Matching Type.  Match Column A with Column B. (1 point each) 

Column A                         Column B 

________ 1.  Icons    A.  Icon for a shortcut to a website 

________ 2.      B. Icon for Computer Networks 
 

_______ 3.      C.  Icon for a shortcut to a folder that is on the  

Computer’s hard drive 

__  ___ 4.      D.  Shortcuts are displayed in the desktop as 
 

_______ 5.                   E.  Icon for Internet Explorer  

 

 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 2 
Selecting, Opening and Closing desktop icons to 
access application programs 

2.1. Arrange icons on the desktop 

When you have a lot of icons or shortcuts on the desktop you may want to organise 

them according to either: 
 Their name (alphabetical order) 

 Their size (the amount of data that the icon points to) 

 Their type (group icons for files made with the same program) 

 When they were modified (group the icons according to when they were last 

customised). 

When you arrange the icons according to any of the above preferences they will regroup 
on the desktop and be laid out in rows (if Align to Grid is also selected). 

1. Right-click on an empty area of the desktop—not on an icon. A menu appears. 

2. Click on Arrange Icons by, then from the sub-menu choose your 
preference. (See Figure 1.) 

 

Figure 1:  Arrange Icons by sub-menu showing preferences for how icons can be 

arranged on the desktop (with Align to Grid selected) 
2.2. Select, open and close desktop icons to access application programs 

You can now open an application program from the desktop icon. Click on the 

icon/shortcut for Paint (or another program you have made a shortcut to) to open the 

application.   To close this application, click on the Close button at the top right of the 

window.  

Try opening some other items on the desktop. Remember to close them when you have 
finished. 
Notice that any items you open; it will appear on the Task bar at the bottom of the screen. 

You will need to close all of these items before you shut down the computer. 
 

Self-Check -2 Written Test 
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Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

 MATCHING TYPE: Match Column A with Column B.  Write the letter of the correct 

answer on the space provided before the number. 

  

COLUMN A    COLUMN B  

_____1.  Input   A. Deleting files from the recycle bin   
_____2. Computer desktop B.  Displays icons and shortcuts   

_____3.  Directory    C.  Retrieving files from the recycle bin 
_____4. Word Processor  D.  Another name for Folder   

_____5.sub-directory  E.  Creating another copy of a file to another location 
_____6. Empty Recycle Bin          F.  A folder inside the main folder  
_____7.  Restore Files  G.  Application Software  

_____8.  Copy and Paste  H. data that is entered into the computer.  
_____9.  Cut and Paste  I.  A small white or black arrow   

_____10. Mouse Pointer  J.  Moving a file to another location  
 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet 3 
Manipulating Application windows 

to return original conditions 

 
 
All programs that are loaded on the computer can be accessed from the Programs option on the 
Start menu.  The Start menu is found at the bottom left-hand corner of the screen. 
 

A menu is a list of choices. Sometimes the menu leads to a sub-menu, which contains another list 
of choices. 

 
Opening an Application from the Start menu 

 

Follow these instructions to open a program from the Start menu: 
 

1   Using the mouse click the Start button in the left-hand corner of the screen. 

2   Slide the mouse up to Programs. 

3   Slide across and click on a program, e.g. Microsoft Word. 

Exiting a file 

To exit a file, follow these instructions:  

1.  Click on File in the top menu bar.  

2.  Select Close. 

3.  A dialog box will appear on the screen asking if you want to save changes you made to your file.             
Select Yes.  A blank screen will appear. 
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Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

Go to the Start menu and follow the instructions previously given. 

 

a) List three programs that appear from the Start menu. 

 __________________________________________________________________________ 

 __________________________________________________________________________ 

 __________________________________________________________________________ 

 
(b) List three programs that have a sub-menu (shown by an arrow).  

 

 __________________________________________________________________________ 

 __________________________________________________________________________ 

 __________________________________________________________________________ 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Operation Sheet 1 Creating and Customizing Desktop icons  

 

Task 1: Create desktop icons/shortcuts 

1.  Click and drag an item from a menu. 

2.  Use the Create shortcut command in a window’s File menu. 

Task 2: Create a desktop icon to open the Control Panel 

Follow these steps using your own computer. 

1. Click on Start on the Task Bar. 

2. Click on the menu item Control Panel but keep the mouse button held down and 
drag the mouse pointer from the Control Panel to the Desktop. 

3. The following icon will now be on your desktop: 
 

Task 3: Create a desktop icon to open a program 

1. Click on Start on the Task Bar. 

2. Click on All Programs. 

3. Under All Programs, click on Accessories. 

4. Under Accessories, click on Paint and drag this item to the desktop. (If you don’t 

have Paint on your computer then select a different program.) 

5. You should now have an icon/shortcut to the program on your desktop. 

 

Task 4: Create a desktop icon to open a folder 

1. Double-click on My computer (on the desktop).  
2. Double-click on one of the drives listed under Hard Disk Drives. You will now see a 

list or group of folders that are stored on that drive. 

3. Click once on one of the folders stored on the drive. The name of the folder will now 
be highlighted (which means it is selected). 

4. Click on the File menu at the top of the window and move down the menu and click 

on  
5. A new folder called ‘Shortcut to… (the name of the folder)’ appears in the window. 

Click and drag this shortcut item to the desktop. 
6. The following icon will now be on your desktop (but with a different folder name): 
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Task 5: Delete the shortcut to the DVD/CD drive: 

1.  Right-click on the DVD/CD icon/shortcut so that a menu appears. 

2.  Click on Delete. 

3.  Click on Yes to confirm you want to delete this icon. 

Task 6: Change the size of icons 

You can change the size of icons and the text related to the icons. 

1. Right-click on an empty area of the desktop—not on an icon. A menu appears. 

2. Click on Properties. A Properties box appears. 

3. In the Properties box click on the Appearance tab. 

4. Click on the Advanced button. 

5. Select ‘Icon’ from the Item drop-down box (See Figure 3.) 

6. Change the size of all icons by clicking on the down or up arrows under Size: (for 
Item:). 

7. Change the size of the text related to icons by clicking on the Font size arrows. 

8. Click OK to make the changes OR Cancel to return to the desktop without making 

changes. If you want to make the changes, note the original settings (so that you 

can return and put the sizes back to their original settings). 
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Operation Sheet 2 
Selecting, Opening and Closing desktop icons to 

access application programs 

 

Task 1: Steps to Arrange Icons 

1. Right-click on an empty area of the desktop—not on an icon. A menu appears. 

2. Click on Arrange Icons by, then from the sub-menu choose your 
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Operation Sheet 3 
Manipulating Application windows 

to return original conditions 

 
Task 1: Follow these instructions to open a program from the Start menu: 

 
1   Using the mouse click the Start button in the left-hand corner of the screen. 

2   Slide the mouse up to Programs. 

3   Slide across and click on a program, e.g. Microsoft Word. 

Task 1: To exit a file, follow these instructions:  

1.  Click on File in the top menu bar.  

2.  Select Close. 

3.  A dialog box will appear on the screen asking if you want to save changes you made to your file.             
Select Yes.  A blank screen will appear. 
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Lap Test Practical Demonstration 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________  Time finished:  ________________ 

Instructions: Given necessary templates, tools and materials you are required to 

perform the following tasks within --- hour. 

 

 

Perform the following: Remarks 

1. Arrange the icons 
 

2. Create Desktop Icon of Drive C: 
 

3. Create Desktop Icon on one of the 

items in control Panel 

 

4. Change the picture of one icon  

5. Create a desktop icon to open a 

program 

 

6. Change the icon size and font size 
of one icon in the desktop 

 

 

 

 

 

 

 

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your trainer shall advice you on additional work. But if satisfactory, 

you can proceed to the next topic. 
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Instruction Sheet  LG26: Organize Basic Directory/ Folder Structure and File 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics – 

 Creating and Naming Directories and subdirectories   

 Identifying Attributes of directories   

 moving Subdirectories between directories   

 Renaming Directories  

 Accessing Directories and subdirectories via different paths 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Create and name directories and subdirectories 

 Identify attributes of directories  

 Move subdirectories between directories 

 Rename directories as required  

 Access directories and subdirectories via different paths  

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 3 to 6.  

3. Read the information written in the information “Sheet 1, Sheet 2, Sheet 3, Sheet 4 

and Sheet 5” in page -3, 8, 12,18 and 18 respectively. 

4. Accomplish the “Self-check 1, Self-check 2, Self-check 3, Self-check 4 and Self-

check 5” in page -7, 11, 14,17 and 21 respectively.  

5. If you earned a satisfactory evaluation from the “Self-check” proceed to Operation 

“Sheet 1, Sheet 2, Sheet 3 and Sheet 4” in page -22,23,24 and 25 respectively. 

6. Do the “LAP test” in page – 26 (if you are ready).  

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If unsatisfactory, 

your teacher shall advice you on additional work. But if satisfactory you can proceed to the 

next topic.
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Information Sheet 1 Creating and Naming Directories and subdirectories   

1.1. How data is typically stored on a computer 

Data files such as word documents can be kept on a computer for future uses such as 

editing and printing. To find documents you will need to store them in an organised 

fashion—in the same way you might file documents like lesson notes, bills, letters and 

bank statements at home. 

Just as you might use folders to organise your personal or business documents, you also 

store your computer documents in folders. A folder is only a device for grouping files in 

the same location, not a data file.  

Folders and files can be stored on a computer’s desktop or on a storage device which 

will be able to store hundreds or thousands of documents.  

Folders can be created or moved so that they sit within another folder, and so on. Other 

terms for describing this structure of files and folders grouped within folders are directory 

and sub-directory. 

You will need to decide where you want to save files. There are several types of storage 

devices that may be an option for you, depending on your computer setup. 

1.2. Storage devices 

 Hard disk drive (HDD) 

Your computer will have a hard disk drive. The hard disk drive is in the system unit. 

The hard drive is where the operating system and application programs are kept. If 

you are using a Microsoft Windows operating system, there is also a location called 

My Documents on the hard drive for storing your data files. You can also have a 

removable hard disk drive which has the advantage of being able to store a large 

amount of data and be transported and connected to other computers. 

 Floppy disk drive (FDD) 

A floppy disk is the least expensive storage media. They don’t hold a lot of data but 

they are easily transportable. They can be damaged by smoke, heat, magnets and 

liquid. 

 Memory stick/flash drive/thumb drive/pen drive/USB drive 
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All these terms refer to a small drive that you plug into a USB port (an input connection on 

the system unit). They are small (about the size of a disposable lighter) and can be carried 

easily. They hold more data than a floppy disk. 

 CDs (compact disk) 

 CD-R: (compact disk read-only) are read-only format which means you can read 

the data but you can’t write (add) data to the CD. They often have application 

programs or music stored on them. 

 CD-RW: (compact disk read-write) another form of CD that you can read and write 

to. This means you can add or copy data to this type of CD. You will need a CD 

burner to do this. 

1.3. Arranging icons 

 The icons on the desktop can be arranged so it is easy to find them. This is a good way to 
group programs together that you use a lot. 

 The long way to do this is to drag each icon with the mouse to a place on the desktop. A 
quicker way to arrange icons is to let the computer do it for you. 

 Arranging icons on the desktop 

Follow these steps to arrange the icons on the desktop:  
 

1 Go to the desktop. 
2 Right click an empty space on the desktop. A shortcut menu will appear. 
3 Select Arrange Icons from the shortcut menu.  

4  Click on by Name. 

5 The icons will arrange themselves neatly in alphabetical (A-Z) order. You can also arrange 

them by type, size or date. 

 Icons such as My Computer and the Recycle Bin never change their position when you 
choose this command. You can only move them around by dragging them with the mouse. 

1.4. Using desktop shortcuts 

 Some of the icons are automatically placed on the desktop when Windows is installed. You can 
also create shortcuts. Shortcuts are icons that represent files, folders or programs. They are really 
only a link to the real file or program. In other words, they are like a nickname that stands for a 

person's real name. 

 All shortcuts have a little arrow in the lower-left corner of the icon. This indicates that the icon 

is a shortcut. 

 Any file, folder or program on your computer can be a shortcut. They do not use up much 
room on your hard disk. 
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 It is a good idea only to make useful shortcuts. They should be used for the files or programs 

that you regularly use. 

Drive contains three folders under My Documents:  

1. Customers 

2. Staff 

3. Warehouse. 

The Customers folder has four sub-folders:  

1. CD Basement 

2. Gig Shop 

3. MP3 to go 

4. Music Beat. 

You can set up your own directory and sub-directories by creating new folders within a 

hierarchical structure, depending on a logical or business system for organising the 

directory. 

In our earlier example (Figures 1 and 2) the directory on the floppy disk has this 

hierarchical structure: 



 

ICT ITS1 

Version:01 

Page No.49 
Copyright: Ethiopia Federal TVET  Agency 

 

1.5. Creating a new folder: 

1. Locate the directory or folder in which you want to create a new sub-

directory/folder. 

2. Double-click on this folder to open it.  

3. In the folder window click on the File menu and select New then Folder. This 

creates a new (empty) folder inside the folder you have opened. 

4. Type in the name of the new folder (to replace the default text ‘New Folder’.) 

 

To create more folders at the same level as this, keep selecting New Folder until you 

have all the folders you need. To create one or more folders inside one of the new folders, 

repeat the above steps. 

In this way you can create a hierarchy of folders according to a hierarchical structure. The 

new directory will be set up and ready to save or copy any documents into. In other ways 

You can create folders from: 

 the desktop (right click the mouse, choose new, then folder) 

 My Documents or 

 Microsoft Word 

In My Documents the main heading is called a directory. The sub-folders are called 

sub-directories. 

Follow these steps to create a new folder:  

1. Open My Documents 

2. Click on File in the top toolbar  

3. Scroll down to New on the menu 

4. Click on Folder from the sub-menu 

5. Give the folder a name 
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Self-Check -1 

 

Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

1. All refers to a drive that you plug into USB port except for one. 

A.  flash drive   C.  Pen drive 

B.  CD   drive          D.  Hard drive 

2. The type of CD that has read-only format which means you can read the data but you 

can’t write (Add) data to the CD. 

A. CD-RW    C.  CD-W 

B. CD-WR   D.  CD-R   

3. The type of CD that you can read and write to, which means that you can add or copy 

data to this type of CD. 

A. CD-RW    C.  CD-W 

B. CD-WR   D.  CD-R   

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 2 Identifying Attributes of Directories   

 

2.1. Attributes of Directories 

Sometimes you will need to check the attributes of a fi le or folder to ensure you use it 

appropriately. Or you may wish to set attributes to read-only so that data is not lost or 

changed by someone. 

Attributes define the type of file or directory which could be: 

 read-only  

 hidden  

 archive  

 system. 

2.1.1. To check or change the attributes of a file: 

1.  Double-click on My Computer on the desktop. 

2.  Double-click on a data drive and find a document file. 

3.  Right-click on the file you want to check. 

4.  Select Properties from the menu. 

 

Figure 4: The Properties box for this file shows 

that the file is Read-only. 

 

Under the General tab of the Properties box 

you can check or uncheck the boxes for read-

only or hidden. More attributes are under the 

Advanced button. 

Click OK to save any change to the attributes 

and close the Properties box. 
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2.2. The folder view 

There are many different ways you can display your electronic `filing cabinet' to view your 

files and folders. Some people prefer to see their folders and files listed while others prefer 

to have them displayed as icons. 

Changing the folder view 

Follow these steps to change the folder view.  

1.  Open Windows Explorer 

2.  Select View from the toolbar 

3.  Select how you want your files and folders displayed, e.g. Details 

 You can display files or folders as:  

 icons 

 titles 

 lists 

 details 

2.3. Icons 

The Icons view shows each folder and file as a large icon with its name underneath. If you 

have a lot of folders and files it is difficult to see them all at one time in this view because 

the large icons take up a lot of space. 

List 

The List view is where the files and folders are arranged in columns. You need to use the 

bottom scroll bar or left and right Arrow keys to see all of them. 

Details 

The Details view presents the file system as a list with details about the files and folders. 

These details include the name of file in alphabetical order (A-Z), the size of file, the type 

of file (i.e. Word document, spreadsheet, graphic document) and date and time when it 

was modified, that is, created and/or changed. 

2.4. Changing the view of all folders 

The view options you select only apply to the open folder. If you want to change the view of 

all folders, you must use the Folder Options dialog box. 
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Follow these steps to change the display of all folders and files in the same way: 

1. Open My Documents 

2. Click on Tools on the top toolbar 

3. Click on Folder Options. A dialog box will appear like the one below 

4. Select View 

5. Select the settings you want  

6. Click on “Apply to all Folders” 

7. Click on OK 

2.5. Folder properties 

A folder's 'properties' refers to information about: 

 its type 

 its location 

 its size 

 the number of files and other folders it contains 

 when it was created 

Information about the size of a folder is useful if you need to save the folder on to a floppy 

disk and want to know if it will fit.   
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Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

The _______ view shows each folder and file as a large icon with its name underneath.  

A. Icons 

B. List 

C. Details 

D. All 

The __________ view is where the files and folders are arranged in columns. 

A. Icons 

B. List 

C. Details 

D. All 

The ______ view presents the file system as a list with details about the files and folders. 

A. Icons 

B. List 

C. Details 

D. All 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

 

Information Sheet 3 Renaming Directories 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  

You can ask you teacher for the copy of the correct answers. 
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3.1. Working with folders 

Folders are a way of organizing your files so that it is easy to find them. This is similar to a 

paper filing system. In a paper filing system documents are organized into folders that 

describe what is in them. For instance, a folder called Power Bills will include gas and 

electricity bills and payments. A folder called Stationery would contain stationery orders, bills 

and catalogues. It is important to give files and folders names that you and other members 

of staff can easily recognize.  

3.2. Renaming folders 

You will notice that there is a '+' (plus) or '-' (minus) sign next to the main folders or 

directories. The `+' sign indicates there are sub-folders (sub-directories) within this folder.  

When the folder has a minus sign beside it, it means that all the sub-folders within the folder 

are on view. 

You can rename a folder in the same way that you rename a file. 

Follow these steps to rename a folder: 

1. Open My Documents 

2. Find the folder you want to rename and right click on it 

3. Select Rename from the shortcut menu that appears 

4. Type the new name on top of the old name. As you type, the old name will  

3.3. Deleting folders 

The steps for deleting a folder are the same as for renaming a folder but you select 

Delete rather than Rename from the shortcut menu above. 

Follow these steps to delete a folder: 

1. Open My Documents 

2. Find the folder you want to delete and right click on it  

3. Select Delete from the shortcut menu that appears 
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Rename directories 

You can rename your folders at any time. To do this: 

1.  Right-click on a folder. 

2.  Left-click on Rename in the menu. 

3.  Type in the new folder name. 

4.  Press Enter on the keyboard to save the change.
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Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

1 Which way do you find easier to view the folders and files?  Why? 

 

 

2 Right click on a folder in My Documents and select Properties.  List three bits of 

information that comes up. 

 

 

 

3 Why is there a `+' (plus) symbol next to some folders? 

 

 

 

 

 

 

 

 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 4 Moving Subdirectories between directories   

 

4.1.  Move subdirectories between directories 

Sometimes it is necessary to move a folder to another location or folder. Here are two 

ways you can do this. (Note that you can move a file in the same ways.) 

4.1.1. Use ‘Move to Folder’ 

1. In window view, click once on the folder you want to move (so that it is selected). 

2. In the window’s Toolbar click on the Edit menu and select Move to Folder. 

3. Select the folder you want to move the selected folder to. To do this, scroll up or 

down the list to find the target folder. You may also need to expand folders to find 

the folder you want. To select the target folder, click on the folder name so that it is 

highlighted. 

4. Click on the Move button. 

           Follow these steps to move a folder: 

 1. Open My Documents 

 2. Right click on the folder you want to move 

 3. Click on Cut in the shortcut menu that appears 

 4. Find the new folder you want to move your new folder into 

 5. Right click on an empty space in the new folder 

 6. Click on Paste from the shortcut menu that appears. The moved folder then 

becomes a sub-folder of the new folder. 

You can also move folders using the mouse. To do this put the mouse on a folder name, left 

click the mouse button and keep it pressed down while moving the folder to a new spot. You 

release the mouse when you are in the right spot.  
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4.1.2. Drag the folder to the new location 

Another way to move a folder is to drag the folder to the new location: 

 Click on the folder icon and keep the mouse button down as you drag the folder 

over the top of the target folder. Release the mouse button when the target folder is 

highlighted. OR 

 Click-drag the folder into the window area of an open folder or drive window. 

Follow these steps to drag a file to a new folder: 

1. Go to My Documents 

2. Find the correct folder and click on it to open it  

3. Find the file you want and click on it  

4. Attach the mouse pointer to the file 

5. Use the left mouse button to drag and drop the file into the new folder  
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Self-Check -4 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

Fill the Blank space 

1. Make the structure of files and folders grouped within folders. __________ 
 

2. It is a device for grouping files in the same location, not a data file. _______ 
 
3. It is where the operating system and application programs are kept? __________ 
 

 

 

 

 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 5 Accessing Directories and subdirectories via different paths 

 

1.1. Access directories on your computer 

You can view folders on a drive and the contents of the folders through windows. Double-

clicking on a drive icon or a folder icon opens a window which shows you its contents. 

Access directories and sub-directories 

Figure 1 shows a view of the directories and sub-directories (folders) that are stored on a 

floppy disk. 

 

 

Figure 1: When the Customers folder is selected in the left frame its sub-folders 

are listed in the right frame 
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Figure 2: One folder and three files are contained in this folder 

1.2. Change the view of a folder’s contents 

You can choose a different view (appearance) of the contents of a folder depending on 

what is useful for you. 

 

 

1.  Click on the View menu of a window. 

2.  Select a view from the menu (Thumbnails, Icons, List, Details). 

Try each of these to see the different views. 
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1.3. View a directory tree structure 

Files and folders can be enclosed by any number of folders which creates a hierarchy or 

tree structure. You can change the view of a folder window to see the directory tree 

structure. This allows you to see the whole directory structure as well as the contents of 

any folder in one view.  

An easy way to view the directory tree is to click on the Folders button on a window 

Toolbar (see the window Toolbar in Figure 2). If you can’t see the Folders button on the 

Toolbar, click-drag the right edge of the window to expand the size of the window and its 

Toolbar.  

When you click on the Folders button the directory tree will appear in the frame on the left. 

When you click on a folder its contents are listed in the right frame (see Figure 1 and 

Figure 3). 

 

Figure 3: The folder CD Basement is selected in the left frame so that its contents can be 

viewed in the right frame 

In the left frame you can click on the arrow sign next to a folder to expand the folder—this 

will also show you the contents of the folder (listed in the left frame) under the folder. Click 

on the - sign next to a folder to contract the folder (to hide the contents of the folder). 

To change the window view back to the original view, click on the Folders button again.
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Self-Check -5 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

Say true if the statement is correct, else False 

1. _______ are the structure of files and folders grouped within folders. 
A. Directories 

B. Folder 

C. Files and folders 

D. All 

2. _______ is a device for grouping files in the same location, not a data file. 
A. Directories 

B. Folder 

C. Files and folders 

D. All        

3. _____ can be enclosed by any number of folders which creates a hierarchy or tree 

structure.  
 

A. Directories 

B. Folder 

C. Files and folders 

D. All 

 
 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Operation  Sheet 1 Creating and Naming Directories and subdirectories   

 
Task 1: Follow these steps to arrange the icons on the desktop:  

 

1. Go to the desktop. 
2. Right click an empty space on the desktop. A shortcut menu will appear. 

3. Select Arrange Icons from the shortcut menu.  
4.  Click on by Name. 

5. The icons will arrange themselves neatly in alphabetical (A-Z) order. You can also arrange 

them by type, size or date. 

Task 2:  Follow these steps to create a new folder:  

1. Open My Documents 

2. Click on File in the top toolbar  

3. Scroll down to New on the menu 

4. Click on Folder from the sub-menu 

5. Give the folder a name 
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Operation  Sheet 2 Identifying Attributes of Directories   

 

Task 1: To check or change the attributes of a file: 

1.  Double-click on My Computer on the desktop. 

2.  Double-click on a data drive and find a document file. 

3.  Right-click on the file you want to check. 

4.  Select Properties from the menu. 

Task 2: Follow these steps to change the folder view.  

1.  Open Windows Explorer 

2.  Select View from the toolbar 

3.  Select how you want your files and folders displayed, e.g. Details 

Task 3: Follow these steps to change the display of all folders and files in the same way: 

1. Open My Documents 

2. Click on Tools on the top toolbar 

3. Click on Folder Options. A dialog box will appear like the one below 

4. Select View 

8. Select the settings you want  

9. Click on “Apply to all Folders” 

10. Click on OK 

11. Open My Documents 

12. Find the folder you want to rename and right click on it 

13. Select Rename from the shortcut menu that appears 

14. Type the new name on top of the old name. As you type, the old name will  
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Task 1:  Follow these steps to delete a folder: 

1. Open My Documents 

2. Find the folder you want to delete and right click on it  

3. Select Delete from the shortcut menu that appears 

Task 2: Rename directories 

You can rename your folders at any time. To do this: 

1.  Right-click on a folder. 

2.  Left-click on Rename in the menu. 

3.  Type in the new folder name. 

4.  Press Enter on the keyboard to save the change. 

 

Information Sheet 3 Renaming Directories 
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Information Sheet 4 Moving Subdirectories between directories   

 

Task 1: Follow these steps to move a folder: 

1. Open My Documents 

2. Right click on the folder you want to move 

3. Click on Cut in the shortcut menu that appears 

4. Find the new folder you want to move your new folder into 

5. Right click on an empty space in the new folder 

6. Click on Paste from the shortcut menu that appears. The moved folder then 

becomes a sub-folder of the new folder. 

 

Task 2:  Follow these steps to drag a file to a new folder: 

1. Go to My Documents 

2. Find the correct folder and click on it to open it  

3. Find the file you want and click on it  

4. Attach the mouse pointer to the file 

5. Use the left mouse button to drag and drop the file into the new folder  
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Lap Test Practical Demonstration 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________  Time finished:  ________________ 

Instructions: Given necessary templates, tools and materials you are required to 

perform the following tasks within --- hour. 

Task 1: Create and name directories and subdirectories 

1.  Create the following three directories in a folder called ‘My 

Documents’: 

1. Customers 

2. Staff 

3. Warehouse 

2.  Create the following four sub-directories within the Customers sub-

directory: 

1. CD Basement 

2. Gig Shop 

3. MP3 to go 

4. Music Beat 

3. Create the following three sub-directories within the Staff sub-

directory: 

4. Overtime 

5. Rosters 

6. Timesheets 

4.  Create one sub-directory within the Warehouse sub-directory: 

1. Utilities 

 

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your trainer shall advice you on additional work. But if satisfactory, 

you can proceed to the next topic. 
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Instruction Sheet  LG27: Organize files for users and/or Organization Requirements 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics – 

 Using System browser to search derives 

 Accessing Most common types of files in the directories 

 Selecting, Opening and Renaming Groups of Files    

 Moving Files Between Directories  

 Coping Files to Disks 

 Restoring Deleted files  

 Erasing and formatting Disks 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Use system browser to search drives for specific files  

 Access most commonly used types of files in the directories 

 Select, open and rename groups of files as required   

 mover files between directories  

 Copy files to disks  

 Restore deleted files as necessary  

 Erase and format disks as necessary 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 3 to 6.  

3. Read the information written in the information Sheet “1, 2, 3, 4, 5, 6 and 7” in page -3, 

7, 10,13,15,18 and 21 respectively. 

4. Accomplish the Self-check” 1, 2,3 ,4, 5,6 and 7” in page -6, 9, 12,14,17,20 and 24 

respectively.  

5. If you earned a satisfactory evaluation from the “Self-check” proceed to Operation 

Sheet “1, 2,3,4,5 and 7” in page -25,26,27,28,30 and 31 respectively. 

6. Do the “LAP test” in page – 33 (if you are ready). Your teacher will evaluate your output 

either satisfactory or unsatisfactory. If unsatisfactory, your teacher shall advice you on 

additional work. But if satisfactory you can proceed to the next topic.
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Information Sheet 1 Using System browser to search derives 

 

1.1. Use the search tool to find specific files 

Sometimes files are saved or moved to locations that you can’t remember or just don’t 

know. There may be thousands of folders in a hard drive which would be impossible to 

browse in order to find a lost file. 

Luckily there is search tool that is part of a computer’s operating system. This tool runs an 

automatic search on a drive or within a specific directory (using keywords or the file name) 

to find a file or folder.  

OS Search -- that can help you find anything on your computer, including pictures. 

Windows Search accepts various parameters so that you can customize your search and 

find only files of a specific type. 

You can open the Search Companion (the search tool in Microsoft Windows) in a number 

of different ways—here are three ways to do this. 

1.1.1. Right-click on a folder or drive icon 

1. Right-click on a folder or drive icon and select Search from the menu. This 

will search on the folder or drive you clicked on, e.g. My documents. 

2. Type in either part or all of the file name OR a word or phrase contained in 
the document you are searching for. 

 

Figure 1: Microsoft Windows Search Companion 
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2. Click on the Search button. 

3. The results of the search are listed in the window. There may be more than one 

result for your search. Double-click the correct file to open it, or move the file to 
another location. 

 

Figure 2: Results of a search 

1.1.2. Press the F3 Key 

Alternatively, from the desktop press the F3 key on the top row of your keyboard. You may 

need to select the specific folder or drive you want to search on. 

1.1.3. Go through the Start menu 

Another way to access the Search Companion is to click on Start and select Search from 
the Start menu. Click on the Files and Folders link to go to the same search box as 

shown above. You may need to select the specific folder or drive you want to search on.  

 
 
Figure 3: Results of a search 
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1.1.4. Search a different directory 

The search will be done on whatever folder is selected in the Look in: field.  To search a 

different directory, click on the arrow next to the Look in: field to get a menu of all the 
drives you have access to. Scroll down to the very end of this list and select Browse. 

Then you can search the directory tree to find a specific folder to search. Click on the 
name of the folder you want to search and then click OK. 

1.1.5. Advanced searches 

You can do an advanced search to look for files used in the last week or month when 

searching files and folders in the Search Companion box. 

1.  Click on More Advanced Options 

2.  Select the appropriate setting for your search. 

3.  Click on Search. 
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Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

1. ______ that can help you find anything on your computer, including pictures. 

A. F3 

B. OS Search 

C. F10 

D. Escape 

 

2. _____ key on the top row of your keyboard. You may need to select the specific 

folder or drive you want to search on 

A. F3 

B. OS Search   

C. F10 

D. Escape 

2. Witch one of the following is advanced search to look for files used in the last week 

or month when searching files and folders in the Search Companion box. 

A. Click on More Advanced Options 

B. Select the appropriate setting for your search. 

C. Click on Search 

D. All 

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 2 Accessing Most common types of files in the directories 

 

 
2.1. Accessing files Regularly 

There may be files that you regularly need to access, for example, to update a database or 

use a document template.  

In Microsoft Windows you can create shortcuts to files so that you can quickly access 

them under the Favourites menu. To do this: 

1.  Use any of the above methods to find the file you regularly use. 

  2.  Click on the file name to select it. 

3.  On the window Toolbar click on the Favourites menu. 

4.  Click on Add. 

You can now access the file from the Favourites menu (on any window’s Toolbar) by 

clicking on Favourites and selecting the file. 

2.2. Finding files 

There might be times when you cannot remember where you have stored a file or what 

you have named it. There are two ways to find files. One way is to scroll (with the mouse) 

through all your documents either in Microsoft Word or My Documents. Luckily, there's 

also a quicker way. 

Follow these steps if you need to find a file:  

1. Go to the desktop 

2. Click on Start in the bottom-left corner 

3. Click on Find from the sub-menu  

4. Select Files or Folders. A dialog box will appear 

If you cannot remember the file name, you can search for key words in the text.  Type the 

words in the ‘Containing text’ box in the dialog box. 

2.3. Copy, cut and paste files across directories 

Cut, Copy and Paste are tasks you can do in all application programs and windows such 

as a folder or drive window. You need to make a selection first so that you can cut or copy 
the selection and then paste it in another location. 
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With cut, copy and paste you can remove or move a folder or a file as follows: 

 Cut: Remove file from current location. 

 Copy: Make a copy of the file. 

 Paste: Place a copied or cut file into another location. 

Copying a file 

If you want to keep a file in its original location and also a copy in a new location, follow these 

steps:  1. Open My Documents 

 2. Find the file you want to move 

 3. Right click on the file 

 4. Select Copy from the shortcut menu that appears 

 5. Open the folder where you want to place it (make sure this is created first) 

 6. Right click on an empty space on the screen 

 7. Click on File 

 8. Click on Paste from the menu 

If you have saved a file on to the desktop you can delete it by dragging it to the 

Recycle Bin using the mouse 

2.4. Restoring files 

There might be an occasion when you send a file to the Recycle Bin by mistake, not 

realizing that you might still need that file for some reason. Sometimes you might not 

have kept a copy on file and so need to restore it (get it back). 

Restoring a file from the Recycle Bin 

Follow these steps to restore a file that is in the Recycle Bin: 

1 Double click on the Recycle Bin icon on the desktop to open it 

2 Right click on the file you would like to restore 

3 Click on Restore from the shortcut menu that appears 

The file is restored in its original location. 

If you have only just sent the file to the Recycle Bin and immediately want it back, then 

simply click on the Undo button on the tool bar. (You can also right click an empty area of 

the screen and choose Undo Delete from the shortcut menu that appears.) 
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Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

1. There might be an occasion when you send a file to the Recycle Bin by mistake, not 
realizing that you might still need that file for some reason. 

A. Cut: 
B. Copy: 
C. Paste 

D. restore 

2. Remove file from current location. 

A. Cut: 
B. Copy: 

C. Paste 
D. restore 

 

3. Make a copy of the file. 
A. Cut: 

B. Copy: 
C. Paste 
D. restore 

 
4. Place a copied or cut file into another location. 

A. Cut: 
B. Copy: 
C. Paste 

D. restore 
 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet 3 Selecting, Opening and Renaming Groups of Files    

 
3.1. Select, open and rename groups of files 

Sometimes you may wish to select, open or rename more than one file at a time. 

Select and open more than one file: - 

1. Hold down the Control key (CTRL) and click on each file you want to select. 

Don’t release the Control key until all the files are selected. 

2.  Right-click on one of the selected files and select Open from the menu. 

3.2. Naming and renaming files 

You name a file at the same time that you create it. File names can contain up to 255 
characters (any keystroke on a keyboard). They can have spaces, commas, and 

semicolons and can be in upper and lower case. However, files cannot contain the 
following characters: 

You can rename files at any time. This is useful if you decide the name is not easy for 
other people to identify. To rename more than one file 

1. Select the files to be renamed as you did in step 1 above. 

2. Right-click on one of the selected files and select Rename from the menu. 

3. Type in the new file name. 

Follow these steps to rename a file: 

1 Open My Documents 

2 Find the file you want to rename and right click on it 

3 Click on Rename from the shortcut menu that appears 

4 Type the new name on top of the old name. As you type the old name will 
disappear 

5 Press Enter or click outside the file name 

 
3.3. Deleting files 

It is important to know how to delete files that you no longer need. When there are a lot of 
files stored on the computer, it becomes slower to operate. It is also harder to find files. 

Sometimes you can delete files once you have printed out a copy of the file and placed it 
correctly in the paper filing system. At other times you will need to keep the file on your 
computer so you can make changes to it in the future or update the information in it. Often 

memos or quick messages can be deleted. When you are not sure if you should delete a file, 
ask your supervisor. There are usually rules about what to keep and what to delete. It is up to 
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you to make sure that you regularly tidy your computer filing system. 

 

Follow these steps to delete a file: 

1   Open My Documents 

2   Right click on the file you want to delete 

3   Click on Delete from the shortcut menu that appears 

If you have saved a file on to the desktop you can delete it by dragging it to the 
Recycle Bin using the mouse 
 
3.4. Restoring files 

There might be an occasion when you send a file to the Recycle Bin by mistake, not realizing 

that you might still need that file for some reason. Sometimes you might not have kept a copy 
on file and so need to restore it (get it back). 

 
Restoring a file from the Recycle Bin 
 

Follow these steps to restore a file that is in the Recycle Bin: 

1.  Double click on the Recycle Bin icon on the desktop to open it 

2. Right click on the file you would like to restore 

3. Click on Restore from the shortcut menu that appears 

The file is restored in its original location. 

If you have only just sent the file to the Recycle Bin and immediately want it back, then 
simply click on the Undo button on the tool bar. (You can also right click an empty area of the 
screen and choose Undo Delete from the shortcut menu that appears.) 
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Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

1.  write steps to rename a file? 

   

  
 

2    When you delete the file, where does it go? 

  

 
 3.  How to empty the recycle bin? 

   

  
 

 

 

 

 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 4 Moving Files Between Directories  

4.1. Moving and copying files 

On the computer, you can copy or move a file (or a folder) in a number of ways. This helps 

to keep files organized. 

4.1.1. Moving a file 

Follow these steps to move a file: 

1 Open My Documents 

2 Find the file you want to move.  

3 Right click on the file 

4 Select Cut from the shortcut menu that appears 

5 Open the folder where you want to place it (make sure this is  created first) 

6 Right click on an empty space on the screen 

7 Click on File 

8 Click on Paste from the menu 

4.1.2. Copying a file 

If you want to keep a file in its original location and also a copy in a new location, follow these 

steps: 1 1 1. Open My Documents 

1. 2 2. Find the file you want to move 

2. 3 3. Right click on the file 

3. 4 4. Select Copy from the shortcut menu that appears 

4. 5 5. Open the folder where you want to place it (make sure this is created first) 

5. 6 6. Right click on an empty space on the screen 

6. 7 7. Click on File 

7. 8 8. Click on Paste from the menu 

4.1.3. Dragging a file to a new location 

Follow these steps to drag a file to a new folder: 

1 Go to My Documents 

2 Find the correct folder and click on it to open it  

3 Find the file you want and click on it  

4 Attach the mouse pointer to the file 

5 Use the left mouse button to drag and drop the file into the new folder  
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Self-Check -4 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

If the statement is correct Say True and if the statement is incorrect say False: 

1 Use the right mouse button to drag and drop the file into the new folder  

2 On your computer, you can copy or move a file (or a folder) in a number of ways. 

3 Moving the file means just deleting the file. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet 5 Coping Files to Disks 

3.1. Copy files to a disk 

Copying files means that you can leave the files in their current location and place copies 
in another location. For example, you can copy a file from the hard disk and save it on a 

floppy disk or flash drive. 

Here are the ways you can do this. 

 Copy and Paste a file 

1.  Locate the file you want to copy. 

2.  Right-click on the file. Click on Copy in the menu. 

3.  Right-click in a new location. Click on Paste in the menu. 

 Drag a file from one disk to another 

When you drag a file or folder from one disk or storage media (such as a hard disk) 

to another (such as a flash drive), a copy of the file or folder is automatically made 
at the new location. 

When you do this, make sure you have the destination folder or drive in view—in a 

window or on the desktop. 

1. Click and hold down the mouse button on the file you want to copy. 

2. Drag the file to the destination. If you drag the file on top of a closed 

folder and release the mouse button, then the file will be copied inside 
that folder. 

 Using Keyboard 

Open the USB drive in File Explorer, locate the pictures or the folder containing the 
pictures, and press Ctrl+C. Then, in File Explorer, go to the location you want to 

copy the pictures (e.g., Pictures on the left to open your Pictures folder), and paste 
them by pressing Ctrl+V. 

 Windows command prompt 

The following examples use the Windows command prompt to copy files from one 

drive to another. For general information about using the command line, see 

our Windows command line guide. 

 

https://www.computerhope.com/jargon/e/explorer.htm
https://www.computerhope.com/jargon/f/folder.htm
https://www.computerhope.com/jargon/c/commandi.htm
https://www.computerhope.com/issues/chusedos.htm
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Using the copy command 

You can use the copy command from the command line to 

copy files. 

copy c:\myfile.txt d: 

The above command would copy the file "myfile.txt" on 

the C: drive to the D: drive. 

copy *.txt e: 

The above command uses a wildcard to copy all text files 

in the current directory to the E: drive. 

copy f:\example.xls 

The above command would copy the file "example.xls" on the F: drive to the current 

directory. Notice that we did not specify a destination; if the destination is not specified, the 

current directory is used by default. 

For example, if your command prompt says C:\>, you are in the root of the C:\ drive, so 

the above command would copy F:\example.xls to the destination C:\example.xls. 

 

 
 

 

https://www.computerhope.com/jargon/w/wildcard.htm
https://www.computerhope.com/jargon/c/currentd.htm
https://www.computerhope.com/jargon/r/root.htm
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Self-Check -5 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

1. Here are the ways you can to copy the file in to disk  

A. Using Keyboard 

B. Windows command prompt 

C. Drag a file  

D. All 
 

2. Copying the file from given location in to new drive using keyboard is 

A. Ctrl +V 

B. Ctrl +Alt +Shift 

C. Ctrl +C 

D. Ctrl +Alt +Shift + Delete 

3. Click and hold down the mouse button on the file you want to copy 

A. Using Keyboard 

B. Windows command prompt 

C. Drag a file  
D. All 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 6 Restoring Deleted files  

 

6.1. Delete and restore files 

You may need to delete files or folders, for example, when you no longer need them or 
when they are copied to another disk.  

Here are two ways you can delete a file (a folder can be deleted in the same ways). 

1. Right-click on the file you want to delete 

 Right-click on a file. 

 Left-click on Delete in the menu. 

The file is now moved to the Recycle Bin which sits on the desktop. 

2.   Drag the file to the Recycle Bin 

Another way to delete a file is to drag it to the Recycle Bin on the desktop: 

 Click on the file and hold the mouse button down as you drag it to the 
Recycle Bin. 

 When the file is directly on top of the Recycle Bin the bin will be highlighted. 

At this point release the mouse button and the file will be moved into the bin. 

Figure 6: Icon for the Recycle Bin in Windows  
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6.2. Restore deleted files 

If you have deleted files or folders but not emptied the Recycle Bin you can still get the 
deleted files back. This is called restoring a file. To do this you need to access the 

Recycle Bin from the desktop: 

1. Double-click on the Recycle Bin to open it. Inside this window you can see the files 

that have been deleted. 

2. Right-click on the file you want to restore.  

3. Click on Restore in the menu. The file will be returned to the place it was previously 

deleted from. 

6.3. Empty the Recycle Bin 

Deleted files and folders stay in the Recycle Bin until you empty the bin. If you empty, the 

Recycle Bin anything in it will be permanently deleted (unable to be restored from the 
desktop). It is a good idea to empty the Recycle Bin on a regularly basis, as deleted files 

take up storage space on the computer. 

To empty the Recycle Bin: 

1. Right-click on the Recycle Bin icon. 

2. Select Empty Recycle Bin from the menu. (If there are no files in the bin then this 

option will be faded.) 

The files that were previously deleted (transferred to the bin) are now permanently 

deleted. 
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Self-Check -6 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

 

1. How to empty the recycle bin? 

2. 3 ways to restore a deleted file. 

3.   To Delete a file?                 

A. Right-click on the file you want to delete 

B. Right-click on a file and Left-click on Delete in the menu. 

C. A and B 

D. All 

 

 

 

 

 

 

 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet 7 Erasing and formatting Disks 

 
7.1. Erase and format Disk Drive 

You can format a disk if you want to erase the contents of the disk. You might want to do 

this because you no longer need the data that was stored and you want to reuse the disk. 

You might also want to format the disk if it has a virus. 

7.1.1. To format an external drive in Windows: 

1. Plug your drive into the computer and, if necessary, into a wall outlet. 

2. Open Windows Explorer, click the "Computer" section in the sidebar, and find your 

drive. 

3. Right-click on the drive and choose "Format." 

4. Under "File System," choose the file system you want to use. See the above section 

for more details on which one to pick. 

5. Give your drive a name under "Volume Label," and check the "Quick Format" box. 

6. Click "Start" to format the drive. You'll get a notification when it's done (it should 

only take a few seconds). 

When you're done, open up the drive in Windows Explorer and you can begin dragging 

files to it, or backing up your computer. 

 

Figure 9: Formatting a disk 
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7.1.2. Format a hard drive using the command prompt 
How you can format a hard drive using the command prompt. Before proceeding further, 

make sure your backup all available data to prevent data loss. Follow the steps below to 

format a drive: 

STEP 1:    Open Command Prompt as Administrator 

 

Search for command prompt, right click and run as Administrator. 

STEP 2:    Use Diskpart 

Once command line is open, type 'diskpart' and press Enter. 

STEP 3:    Type List Disk 

The above command will open a Diskpart window. In this window, type 'list disk' and 

press Enter. It will list all the available drives. 

STEP 4:    Select the Drive to Format 

Now type 'select disk (disk number)' as shown above. Specify the drive number which 

needs to be formatted. 

STEP 5:    Clean the Disk 

In this step, type 'clean'. This command will permanent delete all files and folders, and 

successfully clean up the disk. 

STEP 6:    Create Partition Primary 

To make the drive again accessible, type 'create partition primary'. 

STEP 7:    Format the Drive 

Now format the drive with FAT or NTFS file system. Type 'format fs=ntfs' and press 

Enter. 

STEP 8:    Assign a Drive Letter 
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Self-Check -7 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

 

 

4. What are the 2 ways to delete a file? 

5. When you delete the file, where does it go? 

 

 

 

 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 
 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Operation Sheet 1 Using System browser to search derives 

 

You can open the Search Companion (the search tool in Microsoft Windows) in a number 

of different ways—here are three ways to do this. 

1. Right-click on a folder or drive icon 
2. Right-click on a folder or drive icon and select Search from the menu. This will 

search on the folder or drive you clicked on, e.g. My documents. 

3. Type in either part or all of the file name OR a word or phrase contained in the 

document you are searching for. 

4. Click on the Search button 

Advanced searches 

You can do an advanced search to look for files used in the last week or month when 

searching files and folders in the Search Companion box. 

1.  Click on More Advanced Options 

2.  Select the appropriate setting for your search. 

3.  Click on Search. 
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Operation Sheet 2 Accessing Most common types of files in the directories 

 

you can create shortcuts to files so that you can quickly access them under the Favourites 

menu. To do this: 

1.  Use any of the above methods to find the file you regularly use. 

  2.  Click on the file name to select it. 

3.  On the window Toolbar click on the Favourites menu. 

4.  Click on Add. 

Follow these steps if you need to find a file:  

1. Go to the desktop 

2. Click on Start in the bottom-left corner 

3. Click on Find from the sub-menu  

4. Select Files or Folders. A dialog box will appear 

Copying a file 

If you want to keep a file in its original location and also a copy in a new location, follow these 

steps:  1. Open My Documents 

 2. Find the file you want to move 

 3. Right click on the file 

 4. Select Copy from the shortcut menu that appears 

 5. Open the folder where you want to place it (make sure this is created first) 

 6. Right click on an empty space on the screen 

 7. Click on File 

 8. Click on Paste from the menu 

Follow these steps to restore a file that is in the Recycle Bin: 

1. Double click on the Recycle Bin icon on the desktop to open it 

2. Right click on the file you would like to restore 

3. Click on Restore from the shortcut menu that appears 
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Operation Sheet 3 Selecting, Opening and Renaming Groups of Files    

Select and open more than one file: - 

1. Hold down the Control key (CTRL) and click on each file you want to select. 

Don’t release the Control key until all the files are selected. 

2.  Right-click on one of the selected files and select Open from the menu. 

You can rename files at any time. This is useful if you decide the name is not easy for 
other people to identify. To rename more than one file 

4. Select the files to be renamed as you did in step 1 above. 

5. Right-click on one of the selected files and select Rename from the menu. 

6. Type in the new file name. 

Follow these steps to rename a file: 

6 Open My Documents 

7 Find the file you want to rename and right click on it 

8 Click on Rename from the shortcut menu that appears 

9 Type the new name on top of the old name. As you type the old name will 
disappear 

10 Press Enter or click outside the file name 

11 Follow these steps to delete a file: 
12 1   Open My Documents 

13 2   Right click on the file you want to delete 
14 3   Click on Delete from the shortcut menu that appears 

15 If you have saved a file on to the desktop you can delete it by dragging it to the 
Recycle Bin using the mouse 

 

Restoring a file from the Recycle Bin 
 

Follow these steps to restore a file that is in the Recycle Bin: 

4.  Double click on the Recycle Bin icon on the desktop to open it 

5. Right click on the file you would like to restore 

6. Click on Restore from the shortcut menu that appears 
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Operation Sheet 4 Moving Files Between Directories  

 

4.1.4. Moving a file 

Follow these steps to move a file: 

9 Open My Documents 

10 Find the file you want to move.  

11 Right click on the file 

12 Select Cut from the shortcut menu that appears 

13 Open the folder where you want to place it (make sure this is  created first) 

14 Right click on an empty space on the screen 

15 Click on File 

16 Click on Paste from the menu 

4.1.5. Copying a file 

If you want to keep a file in its original location and also a copy in a new location, follow these 

steps: 2 1 9. Open My Documents 

8. 2 10. Find the file you want to move 

9. 3 11. Right click on the file 

10. 4 12. Select Copy from the shortcut menu that appears 

11. 5 13. Open the folder where you want to place it (make sure this is created first) 

12. 6 14. Right click on an empty space on the screen 

13. 7 15. Click on File 

14. 8 16. Click on Paste from the menu 
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4.1.6. Dragging a file to a new location 

Follow these steps to drag a file to a new folder: 

4 Go to My Documents 

5 Find the correct folder and click on it to open it  

6 Find the file you want and click on it  

7 Attach the mouse pointer to the file 

8 Use the left mouse button to drag and drop the file into the new folder  
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Operation Sheet 5 Coping Files to Disks 

 Copy and Paste a file 

1.  Locate the file you want to copy. 

2.  Right-click on the file. Click on Copy in the menu. 

3.  Right-click in a new location. Click on Paste in the menu. 

To empty the Recycle Bin: 

3. Right-click on the Recycle Bin icon. 

4. Select Empty Recycle Bin from the menu. (If there are no files in the bin then this 

option will be faded.) 
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Operation Sheet 7 Erasing and formatting Disks 

7.1.3. To format an external drive in Windows: 

7. Plug your drive into the computer and, if necessary, into a wall outlet. 

8. Open Windows Explorer, click the "Computer" section in the sidebar, and find your 

drive. 

9. Right-click on the drive and choose "Format." 

10. Under "File System," choose the file system you want to use. See the above section 

for more details on which one to pick. 

11. Give your drive a name under "Volume Label," and check the "Quick Format" box. 

12. Click "Start" to format the drive. You'll get a notification when it's done (it should 

only take a few seconds). 

7.1.4. Format a hard drive using the command prompt 
STEP 1:    Open Command Prompt as Administrator 

 

Search for command prompt, right click and run as Administrator. 

STEP 2:    Use Diskpart 

Once command line is open, type 'diskpart' and press Enter. 

STEP 3:    Type List Disk 

The above command will open a Diskpart window. In this window, type 'list disk' and 

press Enter. It will list all the available drives. 

STEP 4:    Select the Drive to Format 

Now type 'select disk (disk number)' as shown above. Specify the drive number which 

needs to be formatted. 

STEP 5:    Clean the Disk 
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In this step, type 'clean'. This command will permanent delete all files and folders, and 

successfully clean up the disk. 

STEP 6:    Create Partition Primary 

To make the drive again accessible, type 'create partition primary'. 

STEP 7:    Format the Drive 

Now format the drive with FAT or NTFS file system. Type 'format fs=ntfs' and press 

Enter. 

STEP 8:    Assign a Drive Letter 
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Lap Test Practical Demonstration 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________  Time finished:  ________________ 

Instructions: Given necessary templates, tools and materials you are required to 

perform the following tasks within --- hour. 

 

Tasks:  

 

1. Format the Flash Drive then change the name of Drive to your name. 

2. Search a file “Serial Number” 

3. Copy the “Serial Number” to the Flash Drive 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your trainer shall advice you on additional work. But if satisfactory, 

you can proceed to the next topic. 
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Instruction Sheet LG28: Print Information 

 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics – 

 Adding Printers and ensuring correct printer setting  

 Changing Default printer 

 Printing Information 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Add printers if required and ensured to have correct printer settings  

 Change default printer if appropriate  

 Print information from an installed printer 

Learning Instructions:  

7. Read the specific objectives of this Learning Guide.  

8. Follow the instructions described below 3 to 6.  

9. Read the information written in the information “Sheet 1, Sheet 2 and Sheet 3” in page 

-3, 8 and 12 respectively. 

10. Accomplish the “Self-check 1, Self-check t 2 and Self-check 3” in page -7, 11 and 14 

respectively.  

11. If you earned a satisfactory evaluation from the “Self-check” proceed to “Operation 

Sheet 1, Operation Sheet 2 and Operation Sheet 3” in page -15, 17 and 18. 

12. Do the “LAP test” in page – 19 (if you are ready).  

 

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your teacher shall advice you on additional work. But if satisfactory 

you can proceed to the next topic. 
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Information Sheet 1 Adding Printers and ensuring correct printer setting  

1.1. Basic Printer Concepts 

A printer is a device that accepts text and graphic output from a computer and transfers 

the information to paper, usually to standard size sheets of paper. Printers vary in size, 

speed, sophistication, and cost. In general, more expensive printers are used for higher-

resolution color printing. 

The four printer qualities of most interest to most users are: 

 Color: Color is important for users who need to print pages for presentations or 

maps and other pages where color is part of the information.  

 Resolution: Printer resolution (the sharpness of text and images on paper) is 

usually measured in dots per inch (dpi).  

 Speed: If you do much printing, the speed of the printer becomes important. 

Inexpensive printers print only about 3 to 6 sheets per minute.  

 Memory: Most printers come with a small amount of memory (for example, 

one megabyte) that can be expanded by the user. 

Some Examples of Computer printers: 

 Inkjet Pinter. 

 Laser Printer. 

 Plotters Printer. 

 Dot-matrix Printer and. 

 Thermal Printer. 

 Inkjet Printer: - Inkjet printers one of the user friendly computer printers. ... 

 Laser Printer: 

1.1.1. Selecting the default printer 

Printers that you can access from your computer may be directly connected to your PC or 

you may have access to printers over a network. A network printer could serve many 

computers, so you may not be the only person sending jobs to a printer. In this case it is 

particularly useful to be able to view the progress of your print jobs as they may be sitting 

in a queue waiting to be printed. You can also cancel a print job after you have sent it to 

the printer. 

https://whatis.techtarget.com/definition/dots-per-inch-dpi
https://searchstorage.techtarget.com/definition/megabyte
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1.1.2.  Check printers you can access 

If printing over a network, there may be more than one printer you can access. To check 

the printers that you have access to: 

1. Click on Start and then select the Control Panel. 

2. Double-click on Printers and Faxes to open this item. 

3. In Printers and Faxes, you see the names of the computer/s that you should be 

able to access. 

 

Figure 1: Printers and Faxes (under the Control Panel) where you can see the printer/s 

you have to access. Check printing preferences for a printer 
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Printing preferences include options for printing such as: 

 the size of the paper you are printing to 

 whether the document you are printing has a horizontal (landscape) or vertical 

(portrait) layout 

 whether you want to print on both sides or only one side of the paper 

 how many copies of the document you want to print? 

You can change these options every time you send a document to the printer but you can 

also set default options so that your preferred options are the default until you change 

them. 

To check or change the default printing preferences for your printer: - 

1. In the Printers and Faxes window right-click on the name or icon of the printer. 

(See Figure 2) 

2. Select Printing Preferences from the menu. 

 

Figure 3: The Printing Preferences for Microsoft Office Document Image Writer 
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3. To change the paper size, you want to print on, click on the arrow next to the box  

4. under Page size. Select a different paper size from the popup menu. 

5. To change the orientation of your document page, click in the button next to either  

6. Portrait or Landscape. 

7. Click OK to save any changes or Cancel to keep the same settings. 

The preferences box for a printer will have different options depending on the model of the 

printer, but the basic options shown in Figure 3 should be available for all printers. You 

can select more printing preferences in a program’s Print box at the time of printing. 
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Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

1. What printer could serve many computers so you may not be the only person 
sending jobs to a printer. 

 
2. ____ printer is automatically selected when you send a job to print. 
 

3. Give the four (4) Printing preferences options for printing. 
 

4.  In changing printing preference, what are the 2 orientation of the document? 
 

5. Where you can select more printing preference? 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet 2 Changing Default Printer 

2.1. Default Printer 

If you have access to more than one printer, then one of those printers will be the default 

printer. This means it is automatically selected when you send a job to print. In Figure 1 

you can see that the default printer has a tick on it. 

To set a printer as the default printer: 

1. In the Printers and Faxes window right-click on the name or icon of the printer. 

2. Select Set as Default Printer from the menu. 

 

Figure 2: Right-click on a printer to select Set as Default Printer—to make this printer the 

default. If you only have one printer available, then you will not need to set a default printer. 
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2.2. Print documents 

You can send a document to the printer from the desktop or from within the application 

program that created the document. 

Print one or more documents from the desktop: To print one or more documents 

from the desktop: 

1. Open a folder that contains one or more documents. 

2. Click on the name of the file you want to print. 

3. To print more than one file, hold down the Control (Ctrl) Key on your keyboard and 

keep clicking on files to add them to the selection. 

4. When all the files are selected, right-click on one of the selected files. Select Print 

from the menu. 

All the files you selected will be sent to the printer. 

Print a web page 

To practice printing a document from within an application program, try printing a page 

from a website. Your computer needs to be connected to the Internet and have a web 

browser such as Internet Explorer. 

 Double-click on the Internet Explorer icon on the desktop to open the program. (If 

your web browser is not on the desktop you may need to open the program from 

Start then the All Programs menu.) When the browser program is open you will 

see the Internet Explorer menus at the top of the window. 

 Click on the File menu then select Print from this menu. 
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Figure 4: The Print command is under the File menu 

The Print box allows you to change the printer and change the printing preferences for 

the job. (Note that any changes here do not permanently override the default settings) 

 

 

 

 

 

 

 

 

 

Figure 5: The Print box allows you to change print settings and to print from within an 

application 

When you have made any changes to the print options click on Print to send the page to 
the printer or click on Cancel if you don’t want to print the page. You can print a document 

from within any application program in the same way. That is: 

1. Open the document you want to print (Double-click on the filename if it is not 

already open.) 

2. Click on the File menu then select Print. 

3. In the Print box check the printing preferences for your job. 

4. Click on Print. 
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Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

1. You have to access more than one printer, one can be selected automatically, then 

one of those printers will be the ____ 

A. Default printer 

B. Network Printer 

C. Local Printer 

D. Normal printer 

2. List the steps of default printer: 

 

_________________________________________________________ 

_________________________  

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 3 Printing Information 

3.1. View the progress of print jobs 

If a document is taking a long time to print or the printer is busy with other people’s print 

jobs, you can check all the jobs that have been sent to a printer and see where your job is 

in the queue. 

From the queue you can also delete a print job if you decide you want to cancel it. To view 

the progress of a print job: 

1. Open Printers and Faxes in the Control Panel. 

2. Double-click the printer icon to open the print monitor where you can see the jobs 

currently in the queue for that printer. 

Figure 6: Close up of a print queue 

3. The print monitor lists the files that have been sent to the printer which are either in 

progress or waiting to be printed. The order of files in the list is the order they will be 

printed. Check the Status column (next to Document Name) to see the name of 

the file that is currently printing. Once a job has printed it will disappear from the 

queue. 
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3.2. Delete a Print Job 

      To delete a job from the print queue: 

1. In the print monitor window (Figure 6) click on the name of the document you 

want to delete. 

2. Press the Delete key on your keyboard. 

3. The following box appears:  

      

4. Click on Yes to delete the print job. Click on No if you do not want to delete it. 

5. The word Deleting will appear in the Status column. 

Note: If you are working over a network, you cannot usually delete the print jobs that 

some else has sent (as you would not have the permission to do this). 

3.3. Shortcuts to the Print Monitor 

If you are not quick enough the document may start to print before you get a chance to 

delete it. So you may like to use a shortcut to access the print monitor quickly. There may 

be a shortcut to the print monitor on the Task Bar of your desktop. Otherwise, you can 

create a shortcut to a print monitor: 

1. Open Printers and Faxes in the Control Panel. 

2. Click on the printer icon you want to access. Hold down the mouse button and drag 

the icon to the desktop. 

3. A shortcut to the print monitor is now on the desktop. 

You can double-click this icon anytime to check the print jobs sent to this printer and to 

delete the jobs you have sent. 
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Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: If the statement is correct say True Else False 

 

1. If you are working over a network, you cannot usually delete the print jobs that 

some else has sent (as you would not have the permission to do this). 

2. Check the Status column (next to Document Name) to see the name of the file 

that is currently printing. Once a job has printed it will disappear from the queue. 

3. You cannot check all the jobs that have been sent to a printer and see where your 

job is in the queue. 

 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  

You can ask you teacher for the copy of the correct answers. 
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Operation Sheet 1 Adding Printers and ensuring correct printer setting 

To check the printers that you have access to: 

1. Click on Start and then select the Control Panel. 

2. Double-click on Printers and Faxes to open this item. 

3. In Printers and Faxes, you see the names of the computer/s that you should be 

able to access. 

To check or change the default printing preferences for your printer: - 

1. In the Printers and Faxes window right-click on the name or icon of the printer. 

(See Figure 2) 

2. Select Printing Preferences from the menu. 

a.  

3. Figure 3: The Printing Preferences for Microsoft Office Document Image Writer 
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4. To change the paper size, you want to print on, click on the arrow next to the box  

5. under Page size. Select a different paper size from the popup menu. 

6. To change the orientation of your document page, click in the button next to either  

7. Portrait or Landscape. 

8. Click OK to save any changes or Cancel to keep the same settings. 
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Operation Sheet 2 Changing Default Printer 

 

To set a printer as the default printer: 

1. In the Printers and Faxes window right-click on the name or icon of the printer. 

2. Select Set as Default Printer from the menu. 

 

Print one or more documents from the desktop: To print one or more documents 

from the desktop: 

1. Open a folder that contains one or more documents. 

2. Click on the name of the file you want to print. 

3. To print more than one file, hold down the Control (Ctrl) Key on your keyboard and 

keep clicking on files to add them to the selection. 

When all the files are selected, right-click on one of the selected files. Select Print from 

the menu 

You can print a document from within any application program in the same way. That is: 
1. Open the document you want to print (Double-click on the filename if it is not 

already open.) 

2. Click on the File menu then select Print. 

3. In the Print box check the printing preferences for your job. 

4. Click on Print. 
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Operation Sheet 3 Printing Information 

 

To view the progress of a print job: 

1. Open Printers and Faxes in the Control Panel. 

2. Double-click the printer icon to open the print monitor where you can see the jobs 

currently in the queue for that printer. 

3. The print monitor lists the files that have been sent to the printer which are either in 

progress or waiting to be printed. 

To delete a job from the print queue: 

1. In the print monitor window (Figure 6) click on the name of the document you 

want to delete. 

2. Press the Delete key on your keyboard. 

3. The following box appears:  

4. Click on Yes to delete the print job. Click on No if you do not want to delete it. 

5. The word Deleting will appear in the Status column. 

you can create a shortcut to a print monitor: 

1. Open Printers and Faxes in the Control Panel. 

2. Click on the printer icon you want to access. Hold down the mouse button and drag 

the icon to the desktop. 

3. A shortcut to the print monitor is now on the desktop. 

You can double-click this icon anytime to check the print jobs sent to this printer and to 

delete the jobs you have sent. 
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Lap Test Practical Demonstration 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________  Time finished:  ________________ 

Instructions: Given necessary templates, tools and materials you are required to 

perform the following tasks within --- hour. 

 

 

Tasks 1: Print this document 

Tasks 2: Viewing the progress of the print job 

Tasks 3: Deleting a print job 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your trainer shall advice you on additional work. But if satisfactory, 

you can proceed to the next topic. 
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Instruction Sheet  LG29: Operate Application Software 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics – 

 Creating Documents and customizing basic settings 

 Formatting document and creating tables  

 Adding Images and using mail merge  

 Selecting basic print settings and printing documents 

This guide will also assist you to attain the learning outcome stated in the cover page. 

Specifically, upon completion of this Learning Guide, you will be able to – 

 Create documents and customize basic settings to meet page layout conventions  

 Format document and create tables  

 Add images and use mail merge  

 Select basic print settings and print documents 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below 3 to 6.  

3. Read the information written in the information “Sheet 1, Sheet 2, Sheet 3 and Sheet 4” 

in page -3, 11, 25 and 37 respectively. 

4. Accomplish the “Self-check 1, Self-check 2, Self-check 3 and Self-check 4” in page -

10, 24, 36 and 39 respectively.  

5. If you earned a satisfactory evaluation from the “Self-check” proceed to Operation 

Sheet “1, 2 ,3 and 4” in page -40,24,36 and 50 respectively. 

6. Do the “LAP test” in page – 51 (if you are ready).  

 

 

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your teacher shall advice you on additional work. But if satisfactory 

you can proceed to the next topic. 
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Information Sheet 1 Creating Documents and Customizing basic settings 

1.1. Introduction 

Application software utilizes the capacities of a computer directly for a dedicated task. 

Application software is able to manipulate text, numbers and graphics. It can be in the 

form of software focused on a certain single task like word processing, spreadsheet or 

playing of audio and video files. Here we look at the application software types along with 

some examples of application software of each type. 

A word processor is an example of an application software used for the production 

(including composition, editing, formatting, and possibly printing) of any sort of printable 

material. 

Using a computer to create, edit, and print documents. Of all computer applications, word 

processing is the most common. To perform word processing, you need a computer, a 

special program called a word processor, and a printer. A word processor enables you to 

create a document, store it electronically on a disk, display it on a screen, modify it by 

entering commands and characters from the keyboard, and print it on a printer. 

There are a number of word processing packages (software). Among these are 

WordPerfect, AmiPro, Microsoft Word 2003, 2007 and 2010 versions.  Some of them run 

under MS-DOS and others under MS-Windows Operating System environment.   

1.1.1. Files  

Most computers at work or at home will have a number of files on them. These might be 

documents you have created in Microsoft Word, Excel, Access or PowerPoint programs. 

They will all have different names. 

To use a computer effectively you need to know how to create, move, copy, rename and 

delete files. You also need to know how to identify the type of file and information about the 

file. A file is often referred to as a document. 

1.1.2. Organizing Files  

On a home computer you can choose your own way of organizing your files. If you are the 

only one using it you only need to worry that it is clear to you. In an office, however, people 

often share files. It is important that you use a system that everyone understands. If you are 

unsure where to put a file always check with your supervisor. So you can find files easily it is 
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important to organize your files in a way that is logical and clear. One way of organizing files 

is to put them in different folders.  

1.1.3. Opening a Files  

 You can open a file: 

 from My Documents 

 from within a program, e.g. Microsoft Word 

 from the Start menu 

 Opening a file in Microsoft Word. Follow these steps to open a file in Microsoft Word:  

1 Open Microsoft Word 

2 Select File from the top toolbar  

3 Select Open from the menu 

4 Find the folder that the file is in and double click on it to open it  

5 Find the file you need and double click on its name to open it. Another way to open a 

file that was recently created is through the Start menu and then Documents. Point to 

the file you need with the mouse and click on it to open it. 

1.2. Creating Documents  

 There are several ways of creating a file. You can create a file from: 

 My Documents 

 the desktop 

 Microsoft Word or any other program you are in. 

 Creating a file in My Documents. Follow these steps to create a file in My Documents:  

1 Open My Documents  

2 Click on File on the top menu bar 

3 Scroll down the menu and click on New 

4 Select the type of document you would like, e.g. Microsoft Word Document, from the 

sub-menu.  A dialog box 'New Microsoft Word Document' will appear. Type in the 

name of the new document. 

 Creating a file from the desktop, you can create a new file from the desktop by 

selecting a ‘type' of file from the shortcut menu. Follow these steps to create a file from 

the desktop:  

1 Go to your desktop 

2 Right click on the desktop 
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3 Select New from the shortcut menu that appears 

4 Select the type of file you want and the correct program will open 

 Creating a new file in Microsoft Word. Follow these steps to create a file in Microsoft 

Word:  

1 Open Microsoft Word 

2 Click on File on the top toolbar 

3 Select New from the menu 

4 Select Blank Document and a new Word document will open 

1.3. File types 

There are different types of files. You will notice that in Microsoft Word the file always 

comes up with the ending `.doc', for example `Job Application.doc'. This is called a `file 

extension'. Regardless of how the file is created or saved, Microsoft Windows always gives 

it an extension. This identifies the 'type' of document. For example, if you create a 

spreadsheet in Microsoft Excel, the extension is `. Xls’. Some common extensions are 

outlined below. These identify the type of file or program in which the file was created. 

Table 1: Example of file extension 

Program/File Extension 
Microsoft Word .doc,  docx 
Paint Bmp 
PowerPoint .ppt,  pptx 

Microsoft Excel Xls,,  xlsx 
Microsoft Access .mdb,  ACCDB 

 
1.4. Saving Documents 

After Naming and Saving a File Once: Click the Save button  on the Standard toolbar. 

OR Go to the File menu and choose Save. Follow these steps to perform a Save As 
1 Click File from the menu bar. 

2 Select Save As. The Save As Dialog Box appears. 

3 Type a new name for your file in the File name: box. 

4 Click Save. 

1.5. MS Word 

 Using a computer to create, edit, and print documents. Of all computer applications, 

word processing is the most common.  

 To perform word processing, you need a computer, a special program called a word 

processor, and a printer.  

 A word processor enables you to create a document, store it electronically on a 
disk, display it on a screen, modify it by entering commands and characters from 

the keyboard, and print it on a printer. 
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Microsoft 

Office Button 
  Title Bar Menu Bar 

Minimize 

Close 

Restore 

down 

 There are a number of word processing packages (software). Among these are 

WordPerfect, AmiPro, Microsoft Word 2007 and 2010 versions. Some of them run 

under MS-DOS and others under MS-Windows Operating System environment. 

1.6. Customizing basic settings 

When you start Word, you see the Application window, named Document 1-Microsoft 
Word. This is a blank document window, named Document 1. Usually, the window is 

maximized and fills the whole screen. 
 
  

 

 

 

 

Finger 1: Microsoft Word Windows Environment 

When the window is maximized, three buttons namely: minimize, restore and close 

buttons are displayed in the upper-right corner of the screen 

 Title bar: -It is Upper bar and contains the name of application windows, document 

name, different buttons like (save button, undo buttons, Redo button and etc.) and 

control menu like minimize, maximize/restore and close button used to control 

Vertical Scroll  

Ruler 

View Ruler 

Indent Marker 

 
Tool Bar 
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windows. 

 Microsoft Office Button: - The File menu of word 2003 has been replaced with the 

Microsoft Office Button. We can gate new, open, save, and etc. commands on the 

Microsoft office button. 

 Menu bar: - Contains seven menus. Menu bare contains menus lake Home, Insert, 

page layout, References, Mailings, Review and View. Each menu contains different 

buttons. 

 Ruler: - shows you where your margins are (i.e. left margin, right margin, top 

margin bottom margin, tabs and indents) and it lets you set them.  

 View Ruler: - To show or hide the horizontal and vertical rulers, click View Ruler at 

the top of the vertical scroll bar. 

 Typing area - is the blank area in the document window where you can type your 

text. 

 Insertion point: - Also known as the cursor shows you where the next characters 

you type will appear. 

 View buttons: - There are five view buttons located in the lower-Right corner of the 

document   window, used to change the way your document is displayed on screen. 

By default, Word uses Print Layout view. 

 Zoom slider: - You can zoom in to get a close-up view of your document or zoom 

out to see more of the page at a reduced size. You can also save a particular zoom 

setting with a document or template. 

 Scroll bar: - There are two scroll bars, Vertical and Horizontal. Used to navigating 

inside windows. 

 Status bar: - Tells you what page you’re on, the total number of pages, and where 

your insertion point is on the page. As you use Word, the status bar sometimes 

displays other information as well. 

1.7. Start Word 2007 

First Click on Start button Click on All programClick on Microsoft office click on 

Microsoft office word 2007     OR 

First Click on Start buttonClick on Run Write WinWordOk. 

1.7.1. Creating New Document  
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Sometimes you need to create a new document when you are in the middle of typing 

another one. You can create a new document even if you have not saved and closed the 

document you are currently working on. 

Click the Microsoft Office ButtonNew   Under Templates, you see options you can 

use to create (A blank document, installed, template and etc.) select one of your option 

Create.  Or   Press Ctrl +N key. 

1.7.2. Entering Text 

 The flashing insertion point shows you where the new character you type will 

appear. 

 You can move the insertion point to a new location by using the four arrow keys 

found on the keyboard. 

 You can also point a new location with your mouse, and then click once to move 

the insertion point. 

1.7.3. Saving Document 

 When you save a file, you can save it to a folder on your hard disk drive, a 

network location, disk, CD, the desktop, or another storage location. 

 You need to identify the target location in the Save in list. 

 To save Document 

Click the Microsoft Office ButtonSave as   Word document type file 

name on File name box  In the Save as type list, click the file format that 

you want to save the file in  Save. 

 To save using keyboard 

Press Ctrl+ S key for your keyboard 
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1.7.4. Close Document 

To close your document you have to options using close command and close button form 

title bar. 

 To close using close Command 

Click the Microsoft Office Button  Close. 

 To close using close button 

Click on Close button from title bar. 

 To close using keyboard 

Press Alt+ F4 Key.  
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Self-Check -1 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

4. Where do the deleted files go? 

a. Trash Box   c.  Recycle Box 

b. Trash Can   d.  Recycle Bin 
5. How can you retrieve and back the deleted files? 

a. Delete   c.  Restore 

b. Rename   d.  Empty Bin 
6. It is an area on the screen that displays programs or information. 

a.  Window   c.  Print Box 

b.  Desktop   d.  Icons 
7. This options makes the window expand to its largest size. 

a.  Scrollbar   c.  Maximize 
b.  Taskbar   d.  Minimize 

8. All shortcuts that have been displayed in the desktop are called what? 

a.  Icons   c.  Directories 
b.  Files   d.  Sub-directories 

 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  
You can ask you teacher for the copy of the correct answers. 
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Information Sheet 2 Formatting document and creating tables  

 
2.1. Formatting a Document 

Formatting refers to all the techniques that enhance the appearance of your document. In 

Word, you can roughly divide formatting techniques into three categories: Character, 

Paragraph, and Page formatting. Character formatting includes all the features that 

affect individual characters; and the primary character formatting features are boldface, 

italic, font and font size. Features that fall in paragraph formatting include line spacing, 

indents, alignment, tabs, and so on. 

 To make the text bold 

 The Mini toolbar appears automatically when you select text. It also appears 

with the menu when you select text and then right-click. 

 Select the text that you want to make boldSelect Home tabFrom Font 

Group select bold button. 

 To make the text bold using Font dialog box 

 It is possible to change font style using Font dialog box. 

 Select the text that you want to make boldSelect Home tabFrom Font 

Group select Show font dialog box buttonClick on font tabSelect bold 

form font style box. 

                 

 To make the text Italic 

 Select the text that you want to make italicSelect Home tabFrom Font 

Group select Italic button. 

 To make the text italic using Font dialog box 

 It is possible to change font style using Font dialog box. 

 Select the text that you want to make italic Select Home tabFrom Font 

Group select Show font dialog box buttonClick on font tabSelect italic 

Show font button 
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form font style box. 

 To make the text Underline 

 Select the text that you want to make italicSelect Home tabFrom Font 

Group select underline button. 

 To make the text underline using Font dialog box 

 It is possible to change font style using Font dialog box. 

 Select the text that you want to make underline Select Home tabFrom 

Font Group select Show font dialog box buttonClick on font tabSelect 

underline form font style box. 

2.1.1. Changing text font 

 To change font using change font face options 

 Select the text that you want to change font face Select Home tabFrom 

Font Group select Show font face dropdown option choose one of them. 

 To change font using Font dialog box 

 Select the text that you want to change font face Select Home tabFrom 

Font Group select Show font dialog box buttonClick on font tab choose 

one of them form font box. 

2.1.2. Changing text size 

 To change font size using change font size options 

 Select the text that you want to change font size Select Home tabFrom 

Font Group click on Show font size dropdown option choose one of them. 

2.1.3. To change font size using Font dialog box 

 Select the text that you want to change font size Select Home tabFrom 

Font Group select Show font dialog box buttonClick on font tab choose 

one of them form size box. 

2.1.4. Changing font colors 

  To change font color using change font color options 

 Select the text that you want to change font color Select Home tabFrom 

Font Group click on Show font color dropdown option choose one of them. 

 To change font color using Font dialog box 

 Select the text that you want to change font color Select Home tabFrom 
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Font Group select Show font dialog box buttonClick on font tab choose 

one of them form font color box. 

2.1.5. Subscript or superscript 

 To change subscript using subscript button 

 Select the text that you want to make subscript Select Home tabFrom 

Font Group select subscript button. 

 To change subscript using Font dialog box 

 Select the text that you want to make subscript Select Home tabFrom 

Font Group select Show font dialog box buttonClick on font tab check 

the check box of subscript. 

 To change superscript using superscript button 

 Select the text that you want to make superscript Select Home tabFrom 

Font Group select superscript button. 

 To change Superscript using Font dialog box 

 Select the text that you want to make Superscript Select Home tabFrom 

Font Group select Show font dialog box buttonClick on font tab check 

the check box of superscript. 

2.1.6. Changing the Case of Text 

 To change capitalization of a text: 

 Select Home tab  Click on change Case button form font group  select 

(UPPER CASE, lowercase, Sentence case, toggle case, Capitalized 

Each Word). 

 

 

 

 

 

2.1.7. Creating a Drop cap 

 To create Drop cap 

 Click in the paragraph that you want to begin with a drop capClick on 

Insert tabIn the text group select Drooped or In margin.  

 To Remove Drop cap 

Change case 

button 
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 Click in the paragraph that you want to begin with a drop capClick on 

Insert tabIn the text group select Drooped or In margin.  

2.1.8. Paragraph formatting 

 To change line spacing using line spacing button 

 Click in the paragraph that you want to change line spacing Click on home 

tabfrom paragraph group click on Show line spacing dropdown button  

select one of them.  

                                                                     (Line spacing button) 

 To change line spacing using paragraph dialog box 

 Click in the paragraph that you want to change line spacing Click on home 

tabfrom paragraph group click on Show paragraph button  select one of 

them from line spacing box. 

 

                           

 

 

 

2.1.9. Indenting a Paragraph 

 To change Indent using indent box 

 Select the paragraph that you want to indent Click on page layout tab 

ender paragraph group click the arrows next to Indent Left or Indent Right 

to increase or decrease the left indentation of the paragraph. 

 To change Indent using paragraph dialog box 

 Click in the paragraph that you want to indent Click on home tabfrom 

paragraph group click on Show paragraph button  ender paragraph group 

click the arrows next to Indent Left or Indent Right to increase or decrease 

the left indentation of the paragraph. 

 To indent first line 

 Click in the paragraph that first line indent Click on home tabfrom 

paragraph group click on Show paragraph button  select first line indent 

form special box. 

2.1.10. Paragraph Alignment 

Show paragraph 

button 
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 To change paragraph alignment using alignment button 

 Click in the paragraph that you want to align Click on home tabfrom 

paragraph group click on align left or align right or align center or also align 

justify button. 

 

 

 

 

 

 To change paragraph alignment using paragraph dialog box 

 Click in the paragraph that you want to align Click on home tabfrom 

paragraph group click on Show paragraph button select alignment form 

alignment box. 

2.1.11. Tab formatting 

 To set custom tabs: 

 First sate tab stop poisons Click on home tabfrom paragraph group click 

on Show paragraph button  click on Tabs button  Select tab stops 

position and select leader and alignment ok. 

 To delete a custom tab: 

 To delete single tab stop position; (Click on home tabfrom paragraph 

group click on Show paragraph buttonclick on Tabs button Select tab 

stop position and use clear button) 

 To delete all tab, stop position;  

 (Click on home tabfrom paragraph group click on Show paragraph 

buttonclick on Tabs button  clear all) 

2.1.12. Bullet and numbering list 

 To create a numbered list automatically: 

 Type 1, followed by a dot and a space  Type the text for the first item and 

press Enter. And use Enter to continue. (To Stop Press Enter twice) 

 To create a numbered list using numbering button 

 Click on home tab from paragraph group select number format form 

numbering button Type the text for the first item and press Enter. And use 

Left 
align 

Center Right 
Right Justify 
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Enter to continue. 

                                                    

                                                       (Numbering button) 

 

 To create a bulleted list: 

 Type (*) followed by a dot and a space  Type the text for the first item and 

press Enter. And use Enter to continue. (To Stop Press Enter twice) 

To create a bulleted list using bullet button 

 Click on home tab from paragraph group select bullet format form bullet 

button Type the text for the first item and press Enter. And use Enter to 

continue. 

If you want to change the numbers to bullets (or vice versa):  

 Select the entire list  Click on the Bullets or Numbering button from home 

tab on the paragraph group.  

2.1.13. Border and shading  

 To add border 

 Select the picture, table, or text that you want to apply a border select  

Page Layout tabform the Page Background group select page boarders 

buttonclick on border tabfrom style select Line Style and select line 

Color form Color box  Ok 

 To remove border 

 Select the picture, table or text that you want to remove border select  

Page Layout tabform the Page Background group select page boarders 

buttonclick on border tabclick on none box Ok 

 To add shading 

 Select table or text that you want to shading select  Page Layout 

tabform the Page Background group select page boarders buttonclick 

on shading tabselect shading color Ok 

 To remove shading 

 Select table or text that you want to remove shading select  Page Layout 

tabform the Page Background group select page boarders buttonclick 

on shading tabselect no color Ok 
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2.1.14. Page formatting 

 To add page border 

 Select  Page Layout tabform the Page Background group select page 

boarders buttonclick on page boarder tab specify the Type of border you  

Want from Apply to specify in which page you the border apply Ok  

 To remove page border 

 select  Page Layout tabform the Page Background group select page 

boarders buttonclick on page boarder tabclick on none box Ok. 

2.1.15. Header and footer 

 To create header and footer: 

 Select Insert tab in the Header & Footer group, click Header or Footer 

button  Click the header or footer design that you want. 

 To remove header and footer:  

 Select Insert tab in the Header & Footer group, click Header or Footer 

button  Click on remove header and remove footer button. 

2.1.16. Changing Page Margins 

 To insert page margins 

 Select Page Layout tab in the Page Setup group click on page setup 

button  Click on Margins tab  Type a new setting (or use the Up and 

Down arrows next the text box) Ok. 

 To change Orientation 

 Select Page Layout tab in the Page Setup group from orientation 

button select preterit or landscape. 

 

 
  

Table 2: Function of commonly used buttons 

 

Select the style to apply to 
paragraphs 

 

Changes the font of the 
selected text 

 

Changes the size of 
selected text and numbers 

 

Makes selected text and 
numbers bold 

 

Makes selected text and 
 

Underlines selected text and 
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numbers italic numbers 

 

Aligns to the left with a 
ragged right margin 

 

Centers the selected text 

 

Aligns to the right with a 
ragged left margin 

 

Aligns the selected text to 

both the left and right 
margins 

 

Makes a numbered list or 
reverts back to normal 

 

Add, or remove, bullets in a 
selected paragraph 

 

Decreases the indent to 
the previous tab stop 

 

Indents the selected 

paragraph to the next tab 
stop 

 

Adds or removes a border 
around selected text or 
objects  

Marks text so that it is 
highlighted and stands out 

 

Formats the selected text 
with the color you click   

 
Carefully review the function of each of the buttons above. When you think that you are 
familiar with each of the buttons take the short quiz below. (The Formatting toolbar has 

been included as a reference) 

  

 

Column 

 To create Column 

 Place the insertion point where you want the page to break Select Page 

Layout tab in the Page Setup group from Columns button select more 

column buttonEnter number of columns in the Number of Columns text 

box. If you want to insert line between columns, mark the Line Between 

check box select applied location form apply to boxOk 

2.1.17. Page break 

 To create page break 

 Place the insertion point where you want the page to break Select Insert 

tab in the Pages group click on Page break button. Or 
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 Place the insertion point where you want the page to break and Press Ctrl + 

Enter key. 

 To remove page break 

 Place the insertion point on the break in Normal view Press the Delete key 

2.2. Editing a Document 

 To Open an existing file/document: 

 Click the Microsoft Office Button  Open command (ctrl + O).  

 In the Look in list, click the folder, drive, or Internet location that contains the 

file that you want to open. 

 the folder list, locate and open the folder that contains the file 

 Select the file that you want to open Open button. 

2.2.1. Selecting, deleting and move or copy text 

 To Selecting Text: 

 Select text means to highlight it in preparation for performing such as 

deleting it, moving it, and formatting it. 

 In Microsoft Office Word 2007, you can select text or items in a table by 

using the mouse or the keyboard. 

 You can also select text or items that are in different places. 

 To select any length of text using mouse and keyboard: 

 Position the mouse pointer at one end of the block of text you want to select. 

 Holding down the left mouse button, drag the mouse toward the other end 

of the block. 

 To select a word: 

 Move the mouse pointer anywhere over the word and double-click. 

 Place the insertion pointer at the beginning of the word and press       Ctrl 

+Shift +Left Arrow keys. 

 To select a line: 

 Move the mouse pointer to the left of the line, the pointer changes it shape 

and become a white arrow pointer then click once. 

 Place the mouse pointer to the left of the line then Press Shift + Down arrow 

key. 

 To select a sentence: 
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 Move the mouse pointer anywhere over the sentence then holding down 

the Ctrl key click the mouse button, then release the Ctrl key. 

 To select a paragraph: 

 Move the mouse pointer to the left of the paragraph the Double-click. 

 To select the entire document: 

 Ctrl + A 

 Select text in different places: 

 Select some text Hold down CTRL while you select any additional text or 

item in a table that you want 

2.2.2. Delete Text 

You can delete one character at a time or delete a large block of text by selecting it first: 

the remaining text shifts over to fill the vacated space, and line breaks adjust automatically 

 To delete text character by character: 

 If the insertion point is just before the text to be deleted, press the Delete 

key. The Delete key deletes the character to the right of the insertion 

point. 

 If the insertion point is just after the text to be deleted, press the Backspace 

key. The Backspace key deletes the character to the left of the insertion 

point. 

2.2.3. Move and copy text 

 Cut (move): text is removed from the active document and is placed in the 

temporary storage known as clipboard 

 Copy: copy command of Word is the same as the cut command, except 

original text remains in the active document. 

 Paste: The command for placing the texts that was cut or copied to a new 

location. 

2.2.4. To Copy or Move a text using the copy, cut and paste tools:  

 To move:   

 Select the text you want to move. 

 Select Hone tab  Click on Cut Button then point where you want to move 

the text. Then Select Home tab Click on paste Button. 

 To copy:  
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 Select the text you want to copy. 

 Select Hone tab Click on Copy Button then point where you want to Copy 

the text. Then   

 Select Hone tab  Click on paste Button. 

2.2.5. Find and Replace 

 Word find is faster and more accurate than we humans could ever hope to 

be. Sometimes you not only need to find text; you also have to replace it with 

some other text. 

 You can also find and replace noun or adjective forms or verb tenses. 

 To Find Text: 

 On the Home tab, in the Editing group select Find button  Type the text 

you want to find in the Find what text box  Find Next button. Use this 

button again and again.  Close 

 To Replace Text: 

 On the Home tab, in the Editing group select Replace button  Type the 

text you want to find in the Find what text box.  In the Replace with text 

box, type the text that will replace the Find What text. Click on the Find Next 

button. To replace the word, click the Replace button (If you don't want to 

replace this word, click Find Next again to find the next matching word.)  

2.2.6. Check spelling and grammar 

Word 2007 offers improved spelling and grammar checker. The spelling checker 

recognizes a much broader range of names for people, organizations and companies, 

cities and countries Internet and file addresses, and more. 

 To correct the spelling of a word marked with a red wavy underline: 

 Right-click on the word   Click on the correct spelling from the list 

 To fix the grammar of a word or phrase marked with a green wavy line:  

 Right-click on the word  Click on the desired correction 

 To disable automatic spell and grammar checking in any document:  

 Click the Microsoft Office Button Word Options  select proofing 

tab   Clear the check boxes labeled Check Spelling as You Type and 

Check Grammar as You Type.  Ok 

2.2.7. Inserting page number 
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If your document has multiple pages, you can display the page number on each page. In 

most documents, page numbers appear in either the header or the footer of each page.  

Microsoft Office Word 2007 has many preformatted page number designs so that you can 

quickly insert headers or footers that display the page number. 

 To Inserting Page Number: 

 Click on the Insert tab in the Header & Footer group, click Page 

Number  Click Top of Page or Bottom of Page, depending on where you 

want page numbers to appear in your document. 

 Place the page number in the side margin of the page: 

 Click on the Insert tab in the Header & Footer group; click Page 

Number  Click on Page Margins  Choose a page number design from 

the gallery of designs. 

 Formatting page number: 

 Click on the Insert tab in the Header & Footer group; click Page 

Number  Click on Format page numberSelect page format and edit 

starting page number. 

 Remove page number 

 Click on the Insert tab in the Header & Footer group; click Page 

Number  Click on Remove page number. 

2.2.8. Undo and Redo 

Word lets you undo most actions, including typing, deleting, moving and copying, and 

formatting text. In addition, it lets you undo multiple actions, not just your most recent one. 

However, Word cannot undo certain actions, such as opening, saving, or printing a 

document. 

 To undo you’re most recent action: 

 Click on Undo button from Title bar. 

                        Or 

 Press Ctrl + Z key form the keyboard 

 To reverse all your actions back to a certain point: 

 Click on Redo button from Title bar. 

                      Or 

 Press Ctrl + Y key form the keyboard 
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Self-Check -2 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page:  

 A B C D  

1 
  

  

You wish to call attention to a statement in your document 

by making the text bold.  
Which button do you select?     

2 
 

   

A flyer is to be prepared inviting parents to a performance. 
You want the headline to be centered on the page.  
Which button do you select?     

3 
 

  
 

You want to make sure that your instructions are clear and 
plan to place them in a bulleted list.  

Which button do you select?     

4 
   

 

To call attention to a block of text, you want place a block of 
color behind the text to highlight it.  

Which button do you select?     

5 
    

Another way to call attention to a block of text is to place a 

border around it.  
Which button do you select?     

6 
 

  
 

A quoted block of text has been indented. You wish to 

continue the document but you need to undo the indent.  
Which button do you select?     

7 
 

 
  

You have made a birthday certificate and you want the 
student's name to be displayed in color.  
Which button do you select?     

 

 

Answer Sheet 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet 3 Adding Images and using mail merge  

 

3.1. Adding Graphics to a Document 

3.1.1. Add an AutoShape 

 To insert auto shape 

 Select area you want to insert auto shape On the Insert tab in the 

Illustrations group click on Shapes  Click the shape that you want, and 

then drag to place the shape. 

 

 

                                            (Auto shape button) 

 

 To resize auto shape: 

 Select the drawingto resize the drawing, drag one of its selection handles 

when it changes to double arrows. 

 To move auto shape: 

 Select the drawing to move the drawing, drag the mouse when the mouse 

pointer changes to four black arrows. 

 To add text on auto shape: 

 Select the drawingRight-click on the auto shape select add text options. 

3.1.2. Insert a picture 

 To insert picture using Clip art 

 On the Insert tab in the Illustrations group, click on Clip Art buttonIn 

the Clip Art task pane, in the Search for text box, type a word or phrase 

that describes the clip art that you want, or type in all or some of the file 

name of the clip art.  

 To narrow your search, do one or both of the following:  

 To limit the search results to a specific collection of clip art, in the Search in 

box, click the arrow and select the collection you want to search.  

 To limit the search results to clip art, click the arrow in the Results should 

be box and select the check box next to Clip Art.  
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 In the Clip Art task pane, you can also search for photographs, movies, and 

sounds. To include any of those media types, select the check boxes next to 

them. 

 Click Go.  

 In the list of results, click the clip art to insert it.  

 To insert picture using Clip art 

 Click where you want to insert the picture click On the Insert tab in 

the Illustrations group, click Picture. Locate the picture that you want 

to insertDouble-click the picture that you want to insert.  

                            

 

 To resize picture: 

 Select the pictureto resize the picture, drag one of its selection handles 

when it changes to double arrows. 

 To move auto shape: 

 Select the picture to move the picture, drag the mouse when the mouse 

pointer changes to four black arrows. 

3.1.3.  WordArt 

 To insert WordArt 

 On the Insert tab click on the Text group then click WordArt button and 

then click the WordArt style that you want Type your text in the Text 

boxOk.                                             WordArt button 

                             

 To resize WordArt 

 Select the WordArtto resize the WordArt, drag one of its selection handles 

when it changes to double arrows. 

 To move WordArt 

 Select the WordArt to move the WordArt, drag the mouse when the mouse 

pointer changes to four black arrows. 

3.2. Selecting Parts of a table 

3.2.1. Creating Table 
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 To insert table 

 Click where you want to insert a table On the Insert tab, in the Tables 

group click Table and then click Insert Table commandinsert number of 

columns and Rows.  

 To select a cell: 

 Point at the left side within the cell Click once. 

 To select group of cells: 

 Click in the first cell of the group pressing the Shift key, click the last 

cell of the group and release the Shift key. 

 To select a row:  

 Point at the left side of the row outside the table  Click once. 

 To select a column: 

 Point just above the column you want to select Click once. 

 To select multiple contiguous rows/columns: 

 Select the first row or column pressing the Shift key select the last row 

or column.  

 To insert a new row at the bottom of the table: 

 If you want to insert a row at the bottom of the table, just click in the last 

cell of the table (the lower-right cell) and press the Tab or Enter key. 

 To insert a new row in the middle of the table: 

 Select the row where you want to insert the new one Click on Table 

tools tab, Click layout tab, Under Row & column click on Insert 

Above or Below button.  

 To insert a new column in the middle of the table: 

 Select the column where you want to insert the new one Click on Table 

tools tab, Click layout tab, Under Row & column group click on Insert 

Left or Right button.  

 To delete a Row or Column: 

 First select the Row or Column  Click on Table tools tab, Click layout 

tabUnder Row & column group click on Delete Row or Column 

button. 
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 To delete an entire Table: 

 Select the entire table   Click on Table tools tab, Click layout 

tabUnder Row & column group click on Delete table button. 

3.2.2. Merging Cells: 

 Select the Cells to merge  Click on Table tools tab, Click layout 

tabUnder Merge group click on Merge cells button. 

3.3. Mail Merge 

 To create the mail merge 

1. Write your main document and save it and close it. 

2. Open new document and create your data source using tables then save the table 

and close it. 

3. Open your main document and click on mailings tab;  

4. Open your data source; form mailings tab; form select recipients button click on 

use existing list button.   

 

 

 

 

 

5. Insert your fields using insert merged field Button from Mailings tab under write & 

Insert fields group.Insert you’re filed one by one. 

 

 

                                                         (Insert Merge Field Button) 

6. View your merged data using preview Results Button Form Mailings tab under 

Preview Results button. 

                                                              (Preview Results) 

 

 

7. View the user data using next and previous button form Mailings tab under 

preview results group. 

Use existing list 

button 
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8. Edit personal data using Edit personal documents button form mailings tab under 

finish & merge button under finish group. 

 

 

 

 

 

9. Finally save the Edit personal documents.  

 

 

 

 

Firs

t 

Previou

s 

Next Last 

Edit personal 

documents 
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3.4. Starting Excel 2007 

 Startall program Microsoft officeMicrosoft excel 2007  

Exiting Excel 2007 

 When you finish working with Excel, you need to exit by closing its windows. 

Click the Close button in the upper right corner of the Excel Window 

Or 
Choose Microsoft button, click on Close command 

 
3.4.1. Creating a New Workbook 

 Click on Microsoft button New in the New Workbook dialog box clicks on 

Blank workbook Create bottom. 

 Moving around a Worksheet 

 To move the sheet, click and hold the mouse button on the sheet tab and drag the 

sheet. We can also insert new worksheet Insert new worksheet and you can 

rename the worksheet by right click on worksheet tab and rename. 

3.4.2. Saving a Workbook  

To save a new/existing document as a new document: To save new work book:  
Click on Microsoft buttonsave as write workbook name save. 

 To save exiting work book: 

 Click on Microsoft button save.  

3.4.3. Entering Data 

 

 To enter data in a cell: 

 Click the cell  Type the data  

3.4.4. Opening an Existing Workbook 

 
   Click on Microsoft button Open  Select the document you want to 

open  open  
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3.4.5. Selecting Cells 

 To select range of cells: 

 Click one of the cells and drag it down, up, right or left. 

3.4.6. Moving Data 

 To move and replace cells with the cut and paste commands: 

  Select the cell or cells you want to move select Home tabclick on Cut 

command select new locationfrom home tab click on past. 

3.4.7. Copying Data 
 Select the cells you want to copy Select Home tab click on Copy button 

select new Cell  Select Home tab  form past button click on Paste 

Special command  Click one option under Paste Ok. 

3.4.8. Insert or delete cells, rows, and columns 
  Select the same number of cells as you want to insert On the Home tab, 

in the Cells group, click the arrow next to Insert, and then click Insert Cells 

 in the Insert dialog box, click the direction in which you want to shift the 

surrounding cells. 

 Insert blank Rows on a worksheet 
 Select the same number of rows as you want to insert On the Home tab, 

in the Cells group, click the arrow next to Insert, and then click Insert Sheet 

Rows. 

  Insert blank Column on a worksheet 
 Select the same number of columns as you want to insert On the Home 

tab, in the Cells group, click the arrow next to Insert, and then click Insert 

Sheet column. 

3.4.9. Delete cells on a worksheet 

 Select  number of cells as you want to delete On the Home tab, in the Cells 

group, click the arrow next to Delete, and then click Delete Calls 

 Delete Rows on a worksheet 

 Select number of Rows as you want to delete On the Home tab, in the Cells 

group, click the arrow next to Delete, and then click Delete Sheet Rows. 

 Delete columns on a worksheet 

 Select number of Columns as you want to delete On the Home tab, in the Cells 

group, click the arrow next to Delete, and then click Delete Sheet columns. 
3.5. Freezing Worksheet Titles 
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 To Freezing Rows 

 Select the row below where you want the split to appear  On the View tab, in the 

Window group, click Freeze Panes, and then click the Freeze panes. 

 To Freezing Column 

 Select the column to the right of where you want the split to appear On the View 

tab, in the Window group, click Freeze Panes, and then click the Freeze panes. 

To unfreeze rows or column  

 On the View tab, in the Window group, click Freeze Panes, and then click the 

unfreeze panes. 

 
3.5.1. Formatting worksheets 

To change the format of data using font group:  

 Select the cell or range of cells you want to format  To format cell entries as bold 

or italic, click the Bold or Italic tools on the form font group under home tab and you 
can also change font, size, and color. 

To change the format of data using format dialog box:  

 Select the cell or range of cells you want to format on the home tab from font 
group click on show format  dialog select font tab and the  you can  change font, 
size, font style and color. 

 
3.5.2.  Formatting Data with Number Formats 

To assign a number, date or time format: 

 Select the cells you want to format  on the home tab from font group click on 

show format dialog  Select Number tab  In the Category box, select the type of 

entry you want set the Decimal places, 1000 separator, Negative numbers, 

Symbol, Type and Location if they are present based on the entry you selected 

Ok 

To format numbers using Number group: 

 Select the cells you want to format  on the home tab from Number group select 
corresponds to the type of format you want. 
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3.5.3.  Aligning Data with Cells 
To align text using alignment button: 
 Select the cell or range of cells  Click the Alignment button on the Home tab 

under alignment group for the alignment you want. 
To align text using formatting dialog box: 

 Select the cell or range of cells on the Home tab under font group click on show 
format dialog boxSelect alignment tab select the alignment you want. 
 
3.5.4.  Formatting Cells with Borders and Shade 

 

To align text using alignment button: 
 Select the cell or range of cells  Click the Alignment button on the Home tab 

under alignment group for the alignment you want. 

  
To align text using formatting dialog box: 

 Select the cell or range of cells on the Home tab under font group click on show 
format dialog boxSelect alignment tab select the alignment you want. 
 
3.5.5. Series 

To create a series by dragging: 

 Select a range of two cells and enter the first two values  drag the Fill handle to 

the right or down Release the mouse button at the end of the series. 

To create a series with the series command: 

 Enter a starting value and Select the cells  Select home tab forma Editing 

group click on Fill button Series If you want the series to be in a row, select the 

Rows; if you want in column select Column  Select series Type  Enter Step 

value and Stop value  Ok.  

 
3.5.6. Entering Formula 

 To inter formulas 

 First click on the cellpress  (=) sign from keyboardenter your formula 

 To insert function on worksheet: 

 Select the cell into which you want to enter the formula select formula tab  click 

on insert function button  Select a category list box and select your fountain 

category  Select the worksheet function name Ok Select arrange of cells to 

be calculated Ok. 

3.5.7. Filtering 



 

ICT ITS1 

Version:01 

Page No.154 
Copyright: Ethiopia Federal TVET  Agency 

 

 

 Filtering data using Auto filter: 

 Select any cell in the database Select data tab click on Filter button on the 

table Drop–down controls are displayed  Click a drop–down control of the field 

that you want to apply a filter to  Choose one of the items (categories) in the list. 

 To set custom auto filters: 

 Select any cell in the database Select data tab click on Filter button  Click a 

drop – down control of the field you want to apply a filter to click on Custom form 

number filter  Specify the operator in the first drop down Specify the field value 

(select or type in) for comparison in the next drop down  Click one of the And/or 

operator buttons and specify the second comparison criteria if you want Ok. 

3.5.8. Filtering using advanced filters 
 Create a criteria range Select your databaseselect Data tabclick on 

Advanced filter button Select database range on List range box; Select criteria 

range on Criteria range Select the Copy to another location  and select 

location for answerer Ok. 

3.5.9. Pivot table 

 To create a pivot table: 

 Select your database select Insert tab  click on Pivot table button choose 

PivotTable chose worksheet (New worksheet or Existing worksheet)ok 

Drag field buttons at the right side of the dialog box to the Row filter, Column 

labile, values and report filter areas.  

3.6. Chart 

 To create chart: 

1. On the worksheet, arrange the data that you want to plot in a chart. 

2. On the Insert tab, in the Charts group, do one of the following: 

3. Click the chart type, and then click a chart subtype that you want to use.  

4. To see all available chart types, click a chart type, and then click All Chart 

Types to display the Insert Chart dialog box, click the arrows to scroll through 

all available chart types and chart subtypes, and then click the ones that you 

want to use. 

5. The chart is placed on the worksheet as an embedded chart  if you want to 

place the chart in a separate chart sheet. 

javascript:AppendPopup(this,'xldefEmbeddedChart_2')
javascript:AppendPopup(this,'xldefChartSheet_3')
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6. Click the embedded chart or the chart sheet to select it and to display the chart 

tools.  

7. On the Design tab, in the Location group, click Move Chart button.  

8. Under Choose where you want the chart to be placed, do one of the following:  

9. To display the chart in a chart sheet, click new sheet. 

3.6.1. Printing worksheet 

 

 To changing sheet orientation 

 Select the worksheets for which you want to change the orientation 

On the Page Layout tab, in the Page Setup group, click Orientation, 

and then click Portrait or Landscape. 

 To preview worksheet 

 Select the worksheets for which you want to preview  Click on 

Microsoft office button print printer preview. 

3.6.2. Print 

a. Open and activate the workbook that contains the information you want to 

print. 

b. Select your work sheet or your database you want to print. 

c. Choose Microsoft office button Print. The Print dialog box appears. 

d. If you want to change any aspect of the page layout, click the Properties 

button 

e. In the Copies box, enter the number of copies if your and more than one. 

f. In the Print range group, click Page(s) and enter a range of page number 

in the form and to boxes if you want to print less than the entire 

document. 

g. Click Ok to begin printing. 
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Self-Check -3 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 
 1. It is an example of an application software used for the production (including composition,  

editing, formatting, and possibly printing) of any sort of printable material.  

  

 2. It can able to manipulate text, numbers and graphics. 

  

 3. Give at least three (3) word processing packages (software). 

  

 

 

 

Answer Sheet 

 

Name:  _________________________             Date:  _______________

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 3 points            Unsatisfactory - below 3 points  

You can ask you teacher for the copy of the correct answers. 
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Information Sheet 4 Printing a document 

 

4.1. Print a Document 

1. Make sure that a printer was attached to your computer or to the network. 

2. Make sure also that the driver for that printer was already installed in your computer. 

3. Click on Ctrl + P or click on the Office button then click Print 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. After that, a print window will pop-up. Here are the basic things you should know when 

printing a document: 
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If you have many printers installed in your computer, choose the printer you want to use 

here. 

 

 

 

 

 

 

 

      Print all pages 

 

 

Print the current page       

displayed on your 

screen 

 

Print specific page/s only 

Ex. 1-4 – prints pages 1-4 

     1,3-4 – prints page 1  

       and 3 to 4  

     1,5 – prints pages 1 & 5 

 

      Indicates the number of  

copies to be printed 

5.  When you’re done, click OK button to print the document. 
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Self-Check -4 Written Test 

 

Directions:  Answer all the questions listed below. Use the Answer sheet provided in the 

next page: 

 

1. Which one is correct print the document using keyboard? 

A. Ctrl + P 

B. Ctrl + V 

C. Ctrl + R 

D. Ctrl + C 

2. From the printing document procedure which one is the first step?  

A. Make sure that the driver for that printer was already installed in your computer. 

B. Make sure that a printer was attached to your computer or to the network. 

C. a print window will pop-up 

D. click OK button to print the document 

 

 

 

 

 

Answer Sheet 

 

 

 

Name:  _________________________             Date:  _______________ 

 

Score = ___________ 

Rating: ____________ 

Note: Satisfactory rating - 2 points            Unsatisfactory - below 2 points  
You can ask you teacher for the copy of the correct answers. 
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Operation Sheet 1 Creating Documents and customizing basic settings 

 
1.8. Creating Documents  

 There are several ways of creating a file. You can create a file from: 

 My Documents 

 the desktop 

 Microsoft Word or any other program you are in. 

 Creating a file in My Documents. Follow these steps to create a file in My Documents:  

5 Open My Documents  

6 Click on File on the top menu bar 

7 Scroll down the menu and click on New 

8 Select the type of document you would like, e.g. Microsoft Word Document, from the 

sub-menu.  A dialog box 'New Microsoft Word Document' will appear. Type in the 

name of the new document. 

 Creating a file from the desktop, you can create a new file from the desktop by 

selecting a ‘type' of file from the shortcut menu. Follow these steps to create a file from 

the desktop:  

5 Go to your desktop 

6 Right click on the desktop 

7 Select New from the shortcut menu that appears 

8 Select the type of file you want and the correct program will open 

 Creating a new file in Microsoft Word. Follow these steps to create a file in Microsoft 

Word:  

5 Open Microsoft Word 

6 Click on File on the top toolbar 

7 Select New from the menu 

8 Select Blank Document and a new Word document will open 

1.9. Saving Documents 

After Naming and Saving a File Once: Click the Save button  on the Standard toolbar. 
OR Go to the File menu and choose Save. Follow these steps to perform a Save As 
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5 Click File from the menu bar. 

6 Select Save As. The Save As Dialog Box appears. 

7 Type a new name for your file in the File name: box. 

8 Click Save. 
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Operation Sheet 2 Formatting document and creating tables  

 

2.2.9. MS Word Formatting  

 To set custom tabs: 

 First sate tab stop poisons Click on home tabfrom paragraph group click 

on Show paragraph button  click on Tabs button  Select tab stops 

position and select leader and alignment ok. 

 To delete a custom tab: 

 To delete single tab stop position; (Click on home tabfrom paragraph 

group click on Show paragraph buttonclick on Tabs button Select tab 

stop position and use clear button) 

 To delete all tab, stop position;  

 (Click on home tabfrom paragraph group click on Show paragraph 

buttonclick on Tabs button  clear all) 

2.2.10. Bullet and numbering list 

 To create a numbered list automatically: 

 Type 1, followed by a dot and a space  Type the text for the first item and 

press Enter. And use Enter to continue. (To Stop Press Enter twice) 

 To create a numbered list using numbering button 

 Click on home tab from paragraph group select number format form 

numbering button Type the text for the first item and press Enter. And use 

Enter to continue. 

                                                    

                                                       (Numbering button) 

 

 To create a bulleted list: 

 Type (*) followed by a dot and a space  Type the text for the first item and 

press Enter. And use Enter to continue. (To Stop Press Enter twice) 

To create a bulleted list using bullet button 

 Click on home tab from paragraph group select bullet format form bullet 

button Type the text for the first item and press Enter. And use Enter to 
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continue. 

If you want to change the numbers to bullets (or vice versa):  

 Select the entire list  Click on the Bullets or Numbering button from home 

tab on the paragraph group.  

2.2.11. Border and shading  

 To add border 

 Select the picture, table, or text that you want to apply a border select  

Page Layout tabform the Page Background group select page boarders 

buttonclick on border tabfrom style select Line Style and select line 

Color form Color box  Ok 

 To remove border 

 Select the picture, table or text that you want to remove border select  

Page Layout tabform the Page Background group select page boarders 

buttonclick on border tabclick on none box Ok 

 To add shading 

 Select table or text that you want to shading select  Page Layout 

tabform the Page Background group select page boarders buttonclick 

on shading tabselect shading color Ok 

 To remove shading 

 Select table or text that you want to remove shading select  Page Layout 

tabform the Page Background group select page boarders buttonclick 

on shading tabselect no color Ok 

2.2.12. Page formatting 

 To add page border 

 Select  Page Layout tabform the Page Background group select page 

boarders buttonclick on page boarder tab specify the Type of border you  

Want from Apply to specify in which page you the border apply Ok  

 To remove page border 

 select  Page Layout tabform the Page Background group select page 

boarders buttonclick on page boarder tabclick on none box Ok. 

2.2.13. Header and footer 

 To create header and footer: 
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 Select Insert tab in the Header & Footer group, click Header or Footer 

button  Click the header or footer design that you want. 

 To remove header and footer:  

 Select Insert tab in the Header & Footer group, click Header or Footer 

button  Click on remove header and remove footer button. 

 

2.2.14. Changing Page Margins 

 To insert page margins 

 Select Page Layout tab in the Page Setup group click on page setup 

button  Click on Margins tab  Type a new setting (or use the Up and 

Down arrows next the text box) Ok. 

 To change Orientation 

 Select Page Layout tab in the Page Setup group from orientation 

button select preterit or landscape. 

 

3.6.3. Formatting worksheets 

To change the format of data using font group:  

 Select the cell or range of cells you want to format  To format cell entries as bold 

or italic, click the Bold or Italic tools on the form font group under home tab and you 

can also change font, size, and color. 

To change the format of data using format dialog box:  

 Select the cell or range of cells you want to format on the home tab from font 

group click on show format  dialog select font tab and the  you can  change font, 

size, font style and color. 

 

3.6.4.  Formatting Data with Number Formats 

To assign a number, date or time format: 

 Select the cells you want to format  on the home tab from font group click on 

show format dialog  Select Number tab  In the Category box, select the type of 
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entry you want set the Decimal places, 1000 separator, Negative numbers, 

Symbol, Type and Location if they are present based on the entry you selected 

Ok 

To format numbers using Number group: 

 Select the cells you want to format  on the home tab from Number group select 

corresponds to the type of format you want. 

3.6.5.  Aligning Data with Cells 

To align text using alignment button: 

 Select the cell or range of cells  Click the Alignment button on the Home tab 

under alignment group for the alignment you want. 

To align text using formatting dialog box: 

 Select the cell or range of cells on the Home tab under font group click on show 

format dialog boxSelect alignment tab select the alignment you want. 

3.6.6.  Formatting Cells with Borders and Shade 

To align text using alignment button: 

 Select the cell or range of cells  Click the Alignment button on the Home tab 

under alignment group for the alignment you want. 

To align text using formatting dialog box: 

 Select the cell or range of cells on the Home tab under font group click on show 

format dialog boxSelect alignment tab select the alignment you want. 

3.6.7. Series 

To create a series by dragging: 

 Select a range of two cells and enter the first two values  drag the Fill handle to 

the right or down Release the mouse button at the end of the series. 

To create a series with the series command: 

 Enter a starting value and Select the cells  Select home tab forma Editing 

group click on Fill button Series If you want the series to be in a row, select the 

Rows; if you want in column select Column  Select series Type  Enter Step 

value and Stop value  Ok.  
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3.6.8. Entering Formula 

 To inter formulas 

 First click on the cellpress  (=) sign from keyboardenter your formula 

 To insert function on worksheet: 

 Select the cell into which you want to enter the formula select formula tab  click 

on insert function button  Select a category list box and select your fountain 

category  Select the worksheet function name Ok Select arrange of cells to 

be calculated Ok. 

3.6.9. Filtering 

 Filtering data using Auto filter: 

 Select any cell in the database Select data tab click on Filter button on the 

table Drop–down controls are displayed  Click a drop–down control of the field 

that you want to apply a filter to  Choose one of the items (categories) in the list. 

 To set custom auto filters: 

 Select any cell in the database Select data tab click on Filter button  Click a 

drop – down control of the field you want to apply a filter to click on Custom form 

number filter  Specify the operator in the first drop down Specify the field value 

(select or type in) for comparison in the next drop down  Click one of the And/or 

operator buttons and specify the second comparison criteria if you want Ok. 

3.6.10. Filtering using advanced filters 

 Create a criteria range Select your databaseselect Data tabclick on 

Advanced filter button Select database range on List range box; Select criteria 

range on Criteria range Select the Copy to another location  and select 

location for answerer Ok. 

3.6.11. Pivot table 

 To create a pivot table: 

Select your database select Insert tab  click on Pivot table button 

choose PivotTable chose worksheet (New worksheet or Existing 
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worksheet)ok Drag field buttons at the right side of the dialog box to the 

Row filter, Column labile, values and report filter areas. 
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Operation Sheet 3 Adding Images and using mail merge  

 
 

1. Steps for create chart: 

10. On the worksheet, arrange the data that you want to plot in a chart. 

11. On the Insert tab, in the Charts group, do one of the following: 

12. Click the chart type, and then click a chart subtype that you want to use.  

13. To see all available chart types, click a chart type, and then click All Chart 

Types to display the Insert Chart dialog box, click the arrows to scroll through 

all available chart types and chart subtypes, and then click the ones that you 

want to use. 

14. The chart is placed on the worksheet as an embedded chart  if you want to 

place the chart in a separate chart sheet. 

15. Click the embedded chart or the chart sheet to select it and to display the chart 

tools.  

16. On the Design tab, in the Location group, click Move Chart button.  

17. Under Choose where you want the chart to be placed, do one of the following:  

18. To display the chart in a chart sheet, click new sheet. 

2. Steps for Mail Merge 

 To create the mail merge 

10. Write your main document and save it and close it. 

11. Open new document and create your data source using tables then save the table 

and close it. 

12. Open your main document and click on mailings tab;  

13. Open your data source; form mailings tab; form select recipients button click on 

use existing list button.   

 

 

 

 

14. Insert your fields using insert merged field Button from Mailings tab under write & 

Insert fields group. Insert you’re filed one by one. 

Use existing list 

button 

javascript:AppendPopup(this,'xldefEmbeddedChart_2')
javascript:AppendPopup(this,'xldefChartSheet_3')
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                                                       (Insert Merge Field Button) 

15. View your merged data using preview Results Button Form Mailings tab under 

Preview Results button. 

                                                              (Preview Results) 

 

 

16. View the user data using next and previous button form Mailings tab under 

preview results group. 

 

 

                                                             

 

 

 

17. Edit personal data using Edit personal documents button form mailings tab under 

finish & merge button under finish group. 

 

 

 

 

 

18. Finally save the Edit personal documents.  

 

Firs
t 

Previou
s 

Next Last 

Edit personal 

documents 
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Operation Sheet 4 Selecting basic print settings and printing documents 

 

 To changing sheet orientation 

 Select the worksheets for which you want to change the orientation 

On the Page Layout tab, in the Page Setup group, click Orientation, 

and then click Portrait or Landscape. 

 To preview worksheet 

 Select the worksheets for which you want to preview  Click on 

Microsoft office button print printer preview. 

Print 

1. Open and activate the workbook that contains the information you want to print. 

2. Select your work sheet or your database you want to print. 

3. Choose Microsoft office button  Print. The Print dialog box appears. 

4. If you want to change any aspect of the page layout, click the Properties button 

5. In the Copies box, enter the number of copies if your and more than one. 

6. In the Print range group, click Page(s) and enter a range of page number in the 

form and to boxes if you want to print less than the entire document. 

7. Click Ok to begin printing. 
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Lap Test 1 Practical Demonstration 

 

Name:  _____________________________   Date:  ________________ 

Time started: ________________________  Time finished:  ________________ 

Instructions: Given necessary templates, tools and materials you are required to 

perform the following tasks within --- hour. 

 

1. Create New document and save it by the file name of Word exam under D:\Yourname  

2. Create 10 page breaks. 

3. Type the following text on first page  

Using a computer to create, edit, and print documents. Of all computer applications, 
word processing is the most common.  

a) Create three copy of the above paragraphs on black page 

b) Insert page Number at the top of the page in right alignment. 
c) Insert page header Word Exam, page footer your name. 

d) Replace the word printer to save. 
4. Create the following list on new page 

1. Computer  

1.1. Hardware 
1.1.1. Hard disk 

1.1.2. Mouse 
1.1.3. Printer 
1.1.4. Scanner 

1.2. Software 
1.2.1. Application 

1.2.1.1. Ms-Word 
1.2.1.2. Ms-Access 
1.2.1.3. Ms-Excel 

 
5. Create the following tap on the new page 

 
 Name age Tell Salary 

 Solomon ....................25 ------------------- 0911895623 _________ 2500.00 

 Yilma ..........................27 ------------------- 0111892389 _________ 3350.00 
 Girma .........................18 ------------------- 0911897845 _________ 1500.00 
 

 
 

6. Insert page boarder for first page only 
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7. Insert the following auto shapes on new page 

 
  

 
 

 

 
 

 
 

8. Create the following Table on new page  

Student name List 

N o
 Name Competence Hours 

1 Solomon Zegeye Operating personal computer  200 

Connecting hardware peripheral 48 

Total 248 

 

 
 

9. Create the following column on new page 

Menu bar contains seven menus. Menu 

bare contains menus lake Home, Insert, 
page layout, References, Mailings, 

Review and View. Each menu 

contains different buttons. 

 

uler shows you where your margins are 
(i.e. left margin, right margin, top margin 

bottom margin, tabs and indents) and it 

lets you set them.  
 

 

 
10. Create the following on new page 

 

 X2+Y3+X 2X2Y3 
 2H+O2H2O 

Computer 

 Keyboard 
 Mouse 

 Telephone 

 
 

R 

Welcome to 

IT department 

Hello 
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11. Write the following style including watermark 

 

n IT organization or department will accumulate many technical papers, records 

and books. Some documents and manuals may be easy to find, while others can 

be misplaced, lost or damaged. To avoid the latter, methods similar to the 
inventory of hardware and software can be applied to documentation. 

 
 

 
 

 
 
 

 
 

Hardware Name Quantity Manufacturer 

Mouse  10 Dell 

Keyboard 8 Dell 

Monitor 7 Dell  

 
 
 

 
 

 
 

 

  

  

  

  

  

 

12. Save it in My document and close it. 

 

 Your teacher will evaluate your output either satisfactory or unsatisfactory. If 

unsatisfactory, your trainer shall advice you on additional work. But if satisfactory, you 

can proceed to the next topic. 

A 

I know Hardware 

Inventory now! 
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List of Reference Materials 

 

 

1. http://www.euro.who.int/data/assets/pdf_file/0007/115486/E77650.pdf 
 

2. https://www.slideshare.net/catherinelvillanueva1/ict-83930037 

 
3. Microsoft Office step by step guide  

4. Fundamentals of Computing 

5. Introduction to computer  

6. TTLM or modules and journal of ICT 

7. Computer Fundamentals: Pradeep K. Sinha & Priti Sinha  

8. Good Practice in Occupational Health Services by WHO  

http://www.euro.who.int/data/assets/pdf_file/0007/115486/E77650.pdf
https://www.slideshare.net/catherinelvillanueva1/ict-83930037
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Experts 

The development of this Learning Gide for the TVET Program Information technology 

support service Level I. 

No  Name of Trainers  Phone 

Number   

E-mail Address  Region  

1 Abdulakim Ahemed  0921900418  Harari 

2 Assefa Million  0911034866 amen192005@gmail.com  Harari 

3 Derese Teshome  0913938439 dereseteshome@gmail.com  AA 

4 Getenesh Osamo 0923816933 gete.osamo@gmail.com SNNPR 

5 Remedan Mohammed  0913478937 remedanm77@gmail.com  Harari 

6 Sewayehu W/Yohanes  0911716733 Baroke0816@gmail.com SNNPR 

7 Damelash Yihalem 0911912015 demenati@gmail.com  Harari 
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